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SAGLIK BIiLIMLERI ENSTITUSU

Yiiksek lisans oOgrencisi Yasemin Ekiz tarafindan Prof. Dr. Biinyamin Sahin
Danigsmanliginda hazirlanan “Afrika Irkinda Cerebellum Ak ve Gri madde Hacminin
Cinsiyetler Arasinda Stereolojik Yontemlerle Karsilastirilmasi™ baslikli bu c¢alisma
jiirimiz tarafindan ..... /..... /..... tarthinde yapilan sinav ile Tip Fakiiltesi Anatomi
Anabilim Dalinda YUKSEK LISANS Tezi olarak kabul edilmistir.

ONAY:

Bu tez, Enstitii Yonetim Kurulunca belirlenen ve yukarida adlar1 yazili jiiri iiyeleri
tarafindan uygun gorilmiistiir.
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TESEKKUR
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goriintii bankasmi kullanmama izin veren Yrd. Dog. Dr. Amani ELFAKI’ye ve tiim

Anatomi Anabilim Dal1 6gretim tiyelerine tesekkiir ederim.

Samsun’da kaldigim siirece her tiirlii desteklerini hissettigim basta Meltem

ACAR olmak iizere tiim ACAR ailesine tesekkiirii bor¢ biliyorum.

Son olarak Yiiksek Lisans ve diger akademik c¢aligmalarim siiresince gosterdigi
sabir, destek ve fedakarlik i¢cin annem Emine ALTUNTAS olmak iizere tim
ALTUNTAS ailesine ve degerli esim Ahmet EKIZ’e sonsuz saygi ve sevgilerimi

sunuyorum.



OZET

AFRIKA IRKINDA CEREBELLUM AK VE GRi MADDE MiKTARININ
CINSIYETLER ARASINDA STEREOLOJIK YONTEMLERLE
KARSILASTIRILMASI

Amag: Insanlarda cerebellar farkliliklar birgok arastirmaci tarafindan incelenmistir. Bu
caligmalarin ¢ogunda erkeklerin cerebellum hacminin kadinlardan biiylik oldugu
bulunmustur. Bu c¢alismada cerebellum ak ve gri madde hacmi ve hacim oranlarinin

cinsiyetler arasindaki farkini incelemeyi amagladik.

Materyal ve Metod: Saglikli 42 erkek ve 28 kadina ait, 1| mm kalinhiinda ardigik
kesitlerden olugsan beyin Manyetik Rezonans (MR) goriintiileri Siemens 1,5 Tesla
Magnetom Avanto Vision Sistem cihazi kullanilarak elde edildi. OsiriX programiyla T1
agirlikli koronal goriintiiler sagittal yonelimde Talairach diizlemine uygun 1mm
kalinliginda kesit serilerine dontistiiriildii. Kesit yiizey alanlar1 ImageJ programinda
oOl¢iildii. Cavalieri prensibine uygun olarak kesit yiizey alanlarinin toplaminin kesit

kalinlig1 ile carpimindan beyincik ve ak madde hacimleri ve hacim oranlar1 hesaplandi.

Bulgular: Calismamizdaki tim bireylerin ortalama cerebellum hacmi 144,78 cm®

olarak hesap edildi. Erkeklerde cerebellum hacmi ortalama 149,75 cm?®, kadinlarda ise
137,30 cm® olarak hesaplandi1 (p<0,05). Tiim bireylerin ortalama ak madde hacmi 44,45
cm? olarak hesap edildi. Erkeklerin ak madde hacmi ortalama 40,48 cm® ve kadinlarin
50,41 cm® olarak tespit edildi (p<0,05). Tim bireylerin ortalama gri madde hacmi
100,31 cm® olarak hesap edildi. Erkeklerde gri madde hacmi ortalama 109,26 cm?,
kadinlarda ise 86,89 cm® olarak hesapland1 (p<0,05). Erkeklerin gri madde hacim
oraninin kadinlardan biiyilik oldugu, kadinlarin ak madde hacim oraninin ise erkeklerden

bliyiik oldugu gozlendi (p<0,05).

Sonug: Bulgularimiza gére cerebellum hacim ve hacim oranlarinda cinsiyetler arasinda
farkliliklar tespit edildi. Calismamizda elde ettigimiz bulgularin cinsiyete bagl yap1 ve

fonksiyon degisikliklerinin yorumlanmasina yardimci olacagini diisiinmekteyiz.
Anahtar Kelimeler: Cavalieri prensibi; cerebellum; hacim; hacim orani; stereoloji

Yasemin EKIiZ, Yiiksek Lisans Tezi
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ABSTRACT

STEREOLOGICAL COMPARISON OF THE WHITE AND GRAY MATTER
VOLUME OF THE CEREBELLUM BETWEEN SEXES IN AFRICAN RACE

Aim: Cerebellar differences in human were studied in many of studies. In most studies
males had larger cerebellar volume than females. The aim of this thesis is estimating the
volume and volume fraction of the cerebellum between sexes.

Material and Method: In the present study 42 males and 28 females images were used.
Consecutive coronal plane MR images of cerebellum in 1 mm section thickness were
done in a SIEMENS 1.5 Tesla machine. T-1 weighted coronal images were converted to
1 mm section thickness of sagittal images in Talairach plane using OsiriX software. The
sectional surface areas were measured by ImageJ software. The volumes of cerebellum
and white matter were estimated by the multiplication of the total sectional surface area
with the section interval.

Results: The mean total cerebellar volumes of all subjects were 144.78 cm®. The mean
cerebellar volumes were 149.75 cm®and 137.30 cm® in males and females, respectively
(p<0.05). The mean cerebellar white matter volumes of all subjects were 44.45 cm®. The
mean cerebellar white matter volumes were 40.48 cm® and 50.41 cm® in males and
females, respectively (p<0.05). The mean of cerebellar gray matter volume of all
subjects was 100.31 cm®. The mean cerebellar gray matter volumes were 109.26 cm?®
and 86.89 cm® in males and females, respectively (p<0.05). The volume fractions of
males gray matter were higher than that of females, the volume fractions of females
white matter were higher than the males.

Conclusion: Our volumetric and volume fractional data showed that there were
differences between sexes. The volume and volume fractions of cerebellum showed sex
dependent differences that may help interpretation of changes in structure and function.

Keywords: Cavalieri principle; cerebellum; stereology; volume; volume fraction.

Yasemin EKIZ, Master Thesis

Ondokuz Mayis University — Samsun, June — 2014
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1. GIRIS

Cerebrum’un belli bolgeleri cinsiyete bagli degisiklikler gosterebilmektedir.
Insan beyninde cinsiyete iliskin varyasyonlar bir¢ok arastirici tarafindan incelenmistir.
Bu caligmalarin ¢ogunda erkek beyin hacminin bayanlardan daha biiyiik oldugu
bildirilmekte olup, beynin gri ve beyaz cevherini dlgen ¢aligmalarda gri cevherin bayan
beyninde, beyaz cevherinde erkek beyninde karsi cinse gore daha yiiksek hacme sahip
oldugu bildirilmektedir (Peter ve ark., 1998; Gur ve ark., 1999; Allen ve ark., 2003;
Leonard ve ark., 2008). Yapilan bazi galismalarda da erkek beyninin kadinlardan
yaklasik 6,5 kat fazla gri cevhere sahip oldugu, kadinlarin ise erkeklerden 10 kat daha
fazla beyaz cevhere sahip oldugu belirtilmistir (Ho ve ark., 1980).

Mevcut c¢alismalarda c¢ok farkli metotlar kullanilarak hacim hesaplamalari
yapitlmistir. Bu metotlar igerisinde stereolojik Ol¢timler disinda voksel tabanl
morfometri, segmentasyon teknigi ve goriintii analiz programlari dahil bir ¢ok farkli
yontem kullanilmistir (Heinonen ve ark., 1998; Schnack ve ark., 2001; Prastawa ve ark.,
2005). Hacim hesaplamalarinda farkli goriintii analiz programlar1 kullanilmaktadir.
Bunlarin igerisinde en yaygin olarak kullanilan programlar, ImageJ ve benzeri Tipta
Dijital Gériintiileme ve lletisim (DICOM) goriintii analizi ve goriintiileme
programlaridir. Bu programlar yardimiyla dogru bir sekilde hacim hesab1 yapilabildigi
yine literatiirde bildirilmektedir (Sahin ve ark., 2006; Acer ve ark., 2007).

Manyetik Rezonans (MR) goriintiileme yontemleri ¢esitli beyin hastaliklarinin
teshis ve tedavisinde ve ndrodejeneratif durumlarla iligkili degisimlerin takibinde
siklikla kullanilmaktadir. MR goriintiileri lizerinden hacim hesaplamalar1 sizofreni,
Alzheimer hastalifi ve epilepsi gibi norolojik ve fizyolojik rahatsizliklarin
goriintiilenmesinde siklikla kullanilmaktadir (Bernasconi ve ark., 2003; Ho ve ark.,
2003; Murphy ve ark., 2003). MR goriintiileme yontemleri ile ilgili yapimin gergek
hacim veya bilesen hacim degisiklikleri hesaplanabilir. Elde edilen veriler incelenerek
ilgili yapinin normal olup olmadigia bakilabilir. Manyetik Rezonans goriintiileri ile
patolojik degisimleri anlamak i¢in beynin normal morfometrik degisimlerini bilmek
onemlidir.

Toplam hacim, hacim orani veya hacim yogunlugu gibi degerler, biyolojik

yapilar1 inceleyen ¢aligmalarda incelenen nicelikler olarak karsimiza siklikla



cikmaktadirlar. Bir yapi igerisinde bulunan bilesenlerin hacmi veya bu bilesenlerin
birbirlerine veya icinde bulunduklari toplam hacme olan oranlari, 6nemli bilgiler
saglayabilen parametrelerdir. Eger bileseni i¢eren yapinin toplam (veya referans) hacim
degeri biliniyorsa, ne oranda hacim kapladigi, yani hacim orani bilinen bilesenin toplam
hacmi de buradan hesaplanabilir. Stereolojideki hacim ve hacim orani yaklasimi
yapilarin bilesenlerinin hacimsel iligkileri hakkinda bilgi vermektedir (Kalkan ve ark.,
2007; Sahin ve ark., 2007; Ekinci ve ark., 2008).

Hacim hesaplamalarinin klinikte siklikla kullanildigi ve bir ¢ok organin hacim
degerindeki degisikliklerin 6nemli oldugu bildirilmektedir. Son yillarda Klinik
uygulamalarda radyolojik tetkiklerden elde edilen goriintiiler {izerinde hacim hesaplama
yontemi olarak Cavalieri prensibinin siklikla uygulandigi gozlenmektedir (Sahin ve
ark., 2008; Acer ve ark., 2009; Sonmez ve ark., 2010; Terzi ve ark., 2011). Bilgisayarl
tomografi (BT) ve MR goriintiileme sistemleri kullanilarak, incelenen yapidan birbirine
paralel ve esit kalinlikta kesit goriintiileri elde edilebilmektedir. Goriintiilerin bu 6zelligi
incelenen yapinin hacminin Cavalieri prensibi ile hesaplanmasina olanak vermektedir.

Daha once cerebellum iizerine yapilan c¢alismalarda purkinje hiicrelerinin
erkeklerde kadinlara oranla % 6-8 daha fazla oldugu gosterilmistir (Hall ve ark., 1975;
Fan ve ark., 2010). Yapilan bagka bir calismada ise cerebellum’da cinsiyete bagh
herhangi bir farklihik gosterilmemistir (Henery ve ark., 1989). Gorilintii analiz
yontemleri kullanilarak yapilan bazi ¢alismalarda cerebellum hemisfer ve vermis’inin
erkeklerde kadinlara gore daha biiyiik oldugu gosterilmistir (Filipek ve ark., 1994; Luft
ve ark., 1998; Raz ve ark., 1998; 2001; Chung ve ark., 2005; Fan ve ark., 2010). Bunun
aksine diger bazi calismalarda ise cerebellum hacminde cinsiyetlere bagh degisiklik
gbzlenmemistir (Luft ve ark., 1998; Nopoulos ve ark., 2000).

Mevcut literatiirde beyincik hacminde ve ak-gri madde oranlarinda cinsiyetler
arasinda farkliliklar olduguna dair caligmalar mevcut degildir. Ancak, irklar arasinda
beynin bazi bolgelerinde farklar olduguna dair bulgular mevcuttur (Chung ve ark.,
2005). Bu nedenle niceliksel olarak beyincik hacmi ile ak-gri madde hacim oranlarinin
incelenmesi ileride yapilacak olan ¢aligmalara yol gosterici olmasi acisindan dneme
sahiptir. Beyincik gri ve beyaz cevher hacmine ait degisiklikler beyincik ve beyincik
atrofisini anlamada ve diger beyin ile ilgili norodejeneratif hastaliklarin teshisinde

yardimci olabilir.



Yapilan literatiir incelemesinde erkekler ve kadinlar arasinda beyincik hacmini
karsilastiran c¢aligmalara rastlanmakla birlikte ak ve gri madde hacimleri ve hacim
oranlarimi karsilagtiran ¢alismalara rastlanamadi. Bu nedenle sunulan ¢alismada erkek
ve kadinlarda cerebellum ak ve gri madde hacmi ile hacim oranlarinin arastirilmasi

amaclandi.



2. GENEL BILGILER

2.1. Cerebellum

Cerebellum fossa cranii posterior’da yerlesmis, motor fonksiyonlarin
koordinasyonu ve kas tonusunun diizenlenmesinde onemli rolii olan bir yapidir.
Cerebellum, rhombencephalon’un metencephalon kismindan gelisir. Encephalon’un
ikinci; rhombencephalon’un ise en biiyiik boliimiidir. Cerebellum’un agirligi santral
sinir sisteminin yaklagik 1/10’unu olusturur, cerebellum’da ki noéronlarin sayisi

fonksiyonel yapisi itibariyle santral sinir sistemindeki tiim néronlarin yarisindan fazladir

(Gokmen, 2008; Taner, 2010).

2.1.1. Cerebellum Dis Yapisi

Cerebellum, dordiincii ventrikiil, pons ve medulla oblongota ile komsudur.
Cerebellum iizerinde bulunan lobus occipitalis’ten tentorium cerebelli denilen dura
mater uzantisi ile ayrilir. Vermis adi verilen ve ortada yer alan boliimiin ve onun
yanlarini ¢evreleyen hemispherium cerebelli’den olusur. Cerebellum yukaridan asagiya
biraz basik, ovalimsi goriinlime sahiptir. Cerebellum’un en genis boyutu transvers
yondedir. Her iki hemisfer arasinda, On tarafta incisiura cerebelli anterior, arka tarafta
ise incisura cerebelli posterior adi verilen centikler bulunur. Onde ve alt yiizde iki
hemisferi birbirinden ayiran genis ve derin oluk olan vallecula cerebelli yer alir.
Cerebellum’un dis ylizeyinde enine seyreden ¢ok sayida paralel ¢izgi ile seyreden
folium cerebelli adi verilen kiigiik katlantilar bulunur. Folium cerebelli denilen bu
katlantilar arasinda fissura cerebelli adi verilen yariklar yer alir. Folium cerebelli’yi
birbirinden ayiran bu oluklardan bazilar1 daha derin olup, bu oluklar beyincigin lop ve

lopguklarini birbirinden ayirir (Sekil 1; Gokmen, 2008).
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Sekil 1. Cerebellum ve 4. ventrikiilii cevreleyen diger rhombencephalon olusumlari (Netter, 2002)
Cerebellum; lobus cerebelli anterior, lobus cerebelli posterior ve lobus

flocculonodularis olmak tizere {i¢ boliime ayrilir. Lobus cerebelli anterior cerebellum’un
ist On ylizlinden goriilebilir ve lobus cerebelli posterior’dan “V” seklinde genis bir yarik
olan ve kollart yukart dogru bakan fissura prima denilen bir yarik ile ayrilir. Lobus
posterior ile lobus flocculonodularis arasinda ise, fissura posterolateralis denilen yarik
bulunur. Fissura horizontalis, cerebellum’un alt yliziinii iist yiizenden ayirmakta olup,
lobulus semilunaris superior ile inferior arasinda yer alir. Fissura secunda ise lobulus
biventer ile tonsilla cerebelli arasinda yer alir (Sekil 2). Cerebellum’un lobus cerebelli
anterior ve lobus cerebelli posterior kisimlarina corpus cerebelli denilir (Arinci, 2006;
Snell, 2011).

Cerebellum’un loplara ayrilmasi fonksiyonel, daha kiiclik boliimlere ayrilmasi
ise anatomik Ozellikler gosterir. Bu bdliimlerin isimlendirilmesi Reil ve Burdach
tarafindan yapilmis olup, isimlendirmelerin bu boliimlerin fonksiyonlariyla baglantis
bulunmamaktadir (G6kmen, 2008).

Lobus cerebelli anterior’u vermis cerebelli’nin lingula cerebelli, lobulus

centralis ve culmen kisimlar1 ile hemispherium cerebelli’nin ala lobuli centralis ve



lobulus quadrangularis kisimlari olusturur. Lobus cerebelli posterior’u vermis
cerebelli’nin declive, folium vermis, tuber vermis, pyramis vermis ve uvula vermis
kisimlar1 ile hemispherium cerebelli’nin lobulus simplex, lobulus semilunaris superior,
lobulus semilunaris inferior, lobulus biventer ve tonsilla cerebelli kisimlar1 olusturur.
Lobus flocculonodularis’i vermis cerebelli’nin nodulus vermis kismi ile hemispherium

cerebelli’nin pedunculus flocculi ve flocculus kisimlari olusturur (Taner, 2010).
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Sekil 2. Cerebellum’un iist ve alt yiizden goriiniimii (Netter, 2002)



Cerebellum loplari, loplarin boliimleri ve bu olusumlara uyan vermis
boliimleri, ad1 gecen tiim yapilarin bir diizlem {izerine acilimlari ile sematik olarak

tanimlanabilir (Tablo 1; Sekil 3).
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Sekil 3. Vermis cerebelli ve hemispherium cerebelli’nin kisimlart (Taner, 2010)



Tablo 1. Cerebellum béliimleri ve boliimler arasindaki yariklar

Lobun ismi Vermis Ayiran yarik Hemisfer boliimii
lobusu
Lobus cerebelli antrerior
Lingula
Fissura
postlingualis
Lobulus Ala lobuli centralis
centralis
Fissura
postcentralis
Culmen Lobulus

quadrangularis

Fissura prima

Lobus cerebelli posterio

—

Declive

Lobulus simplex

Fissura postlunata

Folium vermis

Lobulus semilunaris
superior

Fissura
horizontalis
Tuber Lobulus semilunaris
inferior
Fissura
prepyramidalis
Pyramis Lobulus biventer
Fissura secunda
Uvula Tonsilla cerebelli

Fissura
posterolateralis

Lobus flocculonodularis

| Nodulus

Flocculus

2.1.2. Cerebellum i¢ Yapisi

Cerebellum icte beyaz, dista gri maddeden olusmustur. Cerebellum’un dig

yiiziinii bir kabuk gibi saran gri cevher tabakasina cortex cerebelli adi verilir. I¢ kisimda

bulunan beyaz madde corpus medullare adini alir. Corpus medullare igerisine gémiilii

durumdaki gri cevher kitleleri beyincik c¢ekirdeklerini olusturur. Korteks tabakasi

igerisine dogru uzanan yaprak seklindeki beyaz madde boliimleri laminae alba olarak

isimlendirilir. Cerebellum median kesitlerinde, corpus medullare cerebelli ve bunun

cevresindeki cortex cerebelli kismi, bir agacin dallarmi andirdig1 i¢in bu goériintime

arbor vitae (hayat agaci) adi verilir (Taner, 2010).




1. Cortex Cerebelli

Cortex cerebelli koronal veya transvers diizlemde uzanan bir¢ok yarikla pileli
bir goriiniim almistir. Her bir plika yiizeyel olarak gri cevher tabakasi ile Ortiilii bir
beyaz cevher 6zii icermektedir. Korteks’in gri cevheri tim uzunlugunca tiniform olup
fonksiyonel lokalizasyon yoktur.

Beyincik korteksi distan ice dogru ii¢ tabakadir.

Stratum moleculare, bu tabaka iki tip néron igermekte olup, tabaka gri
renktedir ve dista yildizs: (stellat) hiicreler, icte sepet (basket) hiicrelerinden olusur. Bu
noronlar folialarin uzun eksenine paralel seyreden ince bir ¢ok akson ve dendritik
dallanmalar arasinda dizilidir. Ikinci tabakadaki hiicrelerin dendritik uzantilari ile
liclincii tabakadaki hiicrelerin aksonlari yogun olarak bu tabakada sonlanir. Noroglial

hiicreler bu hiicreler arasinda bulunur.

Stratum purkinjense, sise seklindeki Golgi I tipi hiicrelerden olusan, sari
renkli, dar bir tabakadir. Bir yapraktan gegen transvers kesitte purkinje hiicrelerinin
yiizeysel tabakaya gecgerek ¢ok sayida baglanti yaparken aksonlari, derinindeki graniiler
tabakaya gegerek beyaz cevhere girer ve myelin kilift alarak beyincik ¢ekirdeklerinden
birinde sinaps yapar. Purkinje hiicre aksonlarinin bir kismida beyin sapindaki vestibiiler

cekirdeklerde sinaps yapar.

Stratum granulosum, bu tabaka ¢ok sayida kiigiik graniillii hiicre ile az sayida
biiylik Golgi hiicresinden olusur. Kiiciik hiicrelerin dendritleri ayni tabakada kalirken
aksonlar1 molekiiler tabakada T seklinde dallanma gosterir. Paralel lifler olarak bilinen
bu lifler folium cerebelli’nin uzun eksenine paralel seyrederek, purkinje hiicrelerinin

dendritleri ile sinaps yaparlar (Arinci, 2006; Snell, 2011).

2. Nuclei Cerebelli (Beyincik Cekirdekleri)

Beyincik ¢ekirdekleri orta hattin her iki tarafinda yer alan, beyaz madde
icerisine gdmiilii olarak bulunan gri cevher kiimeleridir. Bu hiicre kiimeleri pedunculus
cerebellaris superior ve pedunculus cerebellaris inferior’lar yolu ile beyincigi terkeden

yollarin biiyiik boliimiinii olustururlar. Her taraftan beyaz cevher ile sarilmis bu 4 ¢ift



¢ekirdege distan ice dogru nucleus dentatus, nucleus emboliformis, nucleus globosus,
nucleus fastigii ad1 verilir.

Nucleus dentatus, cerebellar ¢ekirdeklerin en biiyligii olup mediale bakan
acikligi ile kivrimhi bir kese seklindedir. Agiklik bolgesi hilum nuclei adin1 alir. Nucleus
dentatus’da purkinje hiicrelerinin aksonlar1 sonlanir. Buradan baslayan lifler pedunculus
cerebellaris superior’dan gecerek cerebellum’u thalamus aracilifi ile beyin korteksine
baglar.

Nucleus emboliformis, oval sekilli olup nucleus dentatus’un medialinde
bulunur.

Nucleus globosus, nucleus emboliformis’in medialinde bulunan bir ya da daha
fazla kii¢iik yuvarlak hiicre gruplarindan olusur.

Nucleus fastigii, orta hatta yakin olarak ve vermis’in {ist boliimiiniin 6n ucunda
bulunur. Dordiincii ventrikiiliin tavanina yakin olan bu ¢ekirdek ile dérdiincii ventrikiil

arasinda sadece ince bir beyaz cevher tabakasi bulunur (Gokmen, 2008; Snell, 2011).

3.  Corpus Medullare (Beyaz Madde)

Vermis’te az miktarda, hemispherium cerebelli’de fazla miktarda beyaz madde
bulunmaktadir. Beyaz madde igerisindeki lifler intrinsik, afferent ve efferent lifler
olmak tizere ii¢ grupta toplanir.

1-  Fibrae Propriae (Intrinsik Lifler)

Ara noronlara ait lifler cerebellum igerisinde bulunurlar ve beyincigin yakin ya

da uzak boliimlerini birbirine baglarlar.

Assosiasyon lifleri, bu lifler ayn1 hemisfer igerisindeki folium boéliimlerini birbirine

baglarlar. Assosiasyon lifleri caprazlasmayan, kisa seyirli liflerdir.
Komissural lifler, iki hemisfer boliimiinii birbirine baglayan, uzun seyirli liflerdir.

2-  Afferent Lifler



Beyaz cevherin biiylik kismimni olustururlar. Bu lifler baslica pedunculus
cerebellaris superior ve pedunculus cerebellaris inferior araciligi ile beyincige girerler

ve beyincik korteksinde sonlanirlar.

Afferent liflerin kortekste sonlanmalar1 iki yolla olur. Sinir sisteminin ¢ok
genis bolimiinden geldigi kabul edilen yosunsu (mossy) lifler stratum granulosum’daki
hiicrelerin dendritleri ile sinaps yaparlar. Bu tabakadaki graniiler lifler uyarici

(eksitator), Golgi hiicreleri ise inhibitdr etkiye sahiptir.

Afferent liflerin ikinci sonlanma sekli tirmanici (climbing) lifler ile olur, bu lifler
siklikla tractus olivocerebellaris’i olusturan liflerdir. Bunlar oliva ¢ekirdeklerini

purkinje hiicrelerine baglarlar ve bu lifler sepet ve yildiz hiicreleri ile sinaps yaparlar.

Yosunsu ve tirmanici liflerin her ikiside uyarict 6zelliktedirler (Gokmen, 2008; Snell,

2011).
3-  Efferent Lifler

Cerebellum’un ¢ikisin1 yapan bu lifler, beyincik korteksindeki purkinje
hiicrelerinin aksonlar1 olarak baslarlar. Purkinje hiicrelerinin aksonlarinin biiyiik
cogunlugu cereballar ¢ekirdeklerin noronlarina gider ve burada sinaps yaparak ndron
degistirirler. Nucleus dentatus, nucleus emboliformis, nucleus globosus’ta sinaps yapan
lifler cerebellum’u pedunculus cerebellaris superior’dan, nucleus fastigii’de sinaps
yapan lifler ise pedunculus cerebellaris inferior’dan terk ederler.

Lobus flocculonodularis ve vermis’in bir boliimiindeki purkinje hiicrelerinin bir kismi
ise cerebelar cekirdekleri sinaps yapmadan gecerek nucleus vestibularis lateralis’e

ulasan efferent yollardandirlar (G6kmen, 2008; Snell, 2011).

2.1.3. Pedunculi Cerebellares

Cerebellum viicudun hemen her boliimiinden duyu impulsu alir. Afferentlerinin
efferentlerinden 40 kat daha fazla oldugu tespit edilmistir. Cerebellum, afferent ve
efferent liflerin biraraya gelerek olusturduklari her iki taraftaki ti¢ biiyiik boliim araciligi
ile merkezi sinir sistemin diger parcalarina baglanir. Bu bdliimlere pedunculi

cerebellares adi verilir. Cerebellum, pedunculus cerebellaris inferior ile bulbus’a,



pedunculus cerebellaris medius ile pons’a, pedunculus cerebellaris superior ile

mesencephalon’a baglanir (Gokmen, 2008; Snell, 2011).

2.1.4. Cerebellum’un Yollar

Cerebellum’a etraf yapilardan duyu impulsu getiren liflere afferent yollar,
cerebellum’dan diger yapilara impuls gotiiren liflere de efferent yollar denilir.
Cerebellum’a gelen impulslarin ¢ogu pedunculus cerebellaris inferior ve medius’tan
girer. Efferentleri ise genellikle pedunculus cerebellaris superior’dan cerebellum’u terk

eder.

Cerebellum’un Afferent Yollar:

Cerebellum’a ti¢ ayr1 kaynaktan impuls gelir.

1.  Cortex Cerebri’den Cerebellum’a Gelen Afferent Yollar
1- Tractus corticopontocerebellaris (Tractus pontocerebellaris)

Cortex cerebri’nin frontal, parietal, temporal ve oksipital loblarindaki sinir
hiicrelerinden baslar, corona radiata ve capsula interna’dan gecgerek pons’a gelir ve
buradaki nuclei pontis’ de sinaps yapar. Pons’dan baslayan 2. ndron aksonlari, orta hatti
caprazlayarak, karsi tarafta pedunculus cerebellaris medius’dan girer ve beyincik

korteksi’nde sonlanir.
2- Tractus cortico-olivocerebellaris (Tractus olivocerebellaris)

Cortex cerebri’nin frontal, parietal, temporal ve oksipital loblarindaki sinir
hiicrelerinden baslar, corona radiata ve capsula interna’dan gecgerek bulbus’da nucleus
olivaris inferior’da sonlanir. Buradan baslayan 2. noéron aksonlari, orta hatti
caprazlayarak, karsi tarafta pedunculus cerebellaris inferior’dan girer ve beyincik
korteksi’nde sonlanir. Dengenin devamliliginin stirdiiriilmesi ve stereotipik hareketlerle

ilgili bir demettir.

3- Tractus corticoreticulocerebellaris (Tractus reticulocerebellaris)



Beyin korteksi’nin bircok bolgesinden baslayan lifler, asagi inerek pons ve
medulla oblongata’daki ayni taraf ve karsi taraf formatio reticularis’te sonlanir.
Formatio reticularis’teki hiicreler, aymi taraf pedunculus cerebellaris medius ve
inferior’dan gecerek, beyincik korteksinde sonlanir. Cerebrum ve cerebellum arasindaki
bu baglanti, istemli hareketlerin kontroliinde onemlidir. Bir hareketin baslamasi igin
gereken ilk bilgiler kortekste olusturulduktan sonra kaslarin disipline edilmesi ve

gerektigi kadar caligmasinin bu yolla saglandigi diistiniilmektedir.

2. Medulla Spinalis’den Cerebellum’a Gelen Afferent Yollar

Medulla spinalis’den cerebellum’a ii¢ yoldan suursuz proprioseptif duyu
impulsu gelir.

1- Tractus spinocerebellaris anterior (Gower’s demeti)

Tractus spinocerebellaris anterior, medulla spinalis’in tiim segmentlerinde
bulunur. Bu yol; st ve alt ekstremitelerin kas igcikleri, tendon organlari ve eklem
reseptorlerinden kas- eklem bilgisi tasir. Ayn1 zamanda deri ve fasyadan da basing-
temas duyu impulsu tasimaktadir. Duyunun kaynaklandig: viicut parg¢asinin durumu ve
pozisyonu hakkinda cerebellum’a bilgi vererek, hareket esnasinda kaslarin sinerjik
calismasinda ve dengenin saglanmasinda 6nemli rol oynar. Kas, kiris, bag ve eklem
kapsiiliinden ¢ikan 1. ndronun hiicre gdvdesi ganglion spinale’de bulunur. Ganglion
spinale’den medulla spinalis’e giren aksonlar nuc. thoracicus’da sonlanir. Bu
cekirdekteki aksonlarin biiylik cogunlugu karsi taraftin, az bir kismi ise ayni tarafin
Tractus spinocerebellaris anterioru ile yiikselir. Pedunculus cerebellaris superior’dan

gecerek beyincik korteksinde sonlanir.
2- Tractus spinocerebellaris posterior (Flechsig demeti)

Alt ekstremite ve govdenin kas, kiris ve eklemlerinden aldigi proprioseptif
duyuyu cerebellum’a tasir. Tractus spinocerebellaris anterior’dan farkli olarak her bir
kasin pozisyonu ve hareketinin ince koordinasyonu ile ilgilidir. Proprioseptif duyularin
bir kismi suurumuza ulasak, impulsun kaynaklandigi viicut béliimiiniin gerginligi ve

pozisyonu hakkinda bilgi sahibi oluruz. Ganglion spinale’den medulla spinalis’e giren



aksonlar, nucleus thoracicus’da sinaps yaparlar. Bu noronlarin aksonlari ayni tarafin
funiculus lateralis’inden yukar1 ¢ikarak medulla oblongata’ya yiikselir. Burada
pedunculus cerebellaris inferior’dan cerebellum’a girer ve korteks cerebelli’de yosunsu

lifler olarak sonlanir.
3- Tractus cuneocerebellaris (Fibrae arcutae externae posteriores)

Boyun ve iist ekstremiteler’den (C1-C8) gelen proprioseptif duyuyu tasir.
Medulla spinalis’deki nucleus cuneatus’tan baglayan bu lifler, pedunculus cerebellaris
inferior’dan ayni taraf hemispherium cerebelli’ye girer. Lifler, yosunsu lifler olarak

korteks serebelli’de sonlanir.

3.  Vestibuler Sinirden Gelen Cerebellar Afferent Lifler

Nervus vestibularis, i¢ kulaktaki utriculus ile sacculus’tan yer ¢ekimi ile ilgili
pozisyon duyusunu, ductus semicircularis’lerden de hareket ile ilgili bilgileri alirlar. N.
vestibularis’in bir kisim lifleri kesilmeksizin, bir kisim lifleride nuc. vestibularis’te
noron degistirdikten sonra pedunculus cerebellaris inferior’dan gecerek ayni taraf
beyincik hemisferine girer. Bu liflerin tiimii lobus flocculonodularis’te sonlanirlar

(GOokmen, 2008; Snell, 2011).
Cerebellum’un Efferentleri

Korteks serebelli’nin tiim ¢ikisi, purkinje hiicreleri’nin aksonlar1 aracilig: ile
olur. Purkinje hiicrelerinin aksonlarinin ¢ogu, derin serebellar c¢ekirdeklerdeki
noronlarla sinaps yaparak sonlanirlar. Bir ka¢ purkinje hiicresi aksonu direk olarak
nucleus vestibularis lateralis’e gider. Cerebellum’dan c¢ikan efferent lifler; nucleus
ruber, thalamus, nucleus vestibularis lateralis ve formatio reticularis ile baglanti kurar.

1. Tractus cerebellorubralis

Nucleus globosus ve nucleus emboliformis’den ¢ikan aksonlar, pedunculus
cerebellaris superior’dan cerebellum’u terk eder ve her iki tarafin lifleri orta ¢izgide

caprazlastiktan sonra kars1 tarafin nucleus ruber’inde sonlanir. Nucleus ruber’den ¢ikan



lifler Tractus rubrospinalis olarak tekrar orta hatti ¢aprazlar ve medulla spinalis’in 6n

boynuz motor ndronlari ile sinaps yapar.
2. Tractus cerebellothalamicus

Nucleus dentatus’dan ¢ikan aksonlar, pedunculus cerebellaris superior’dan
cerebellum’u terk ederek orta hatti caprazlar ve karsi tarafin thalamus ¢ekirdeklerinden
nuc. ventralis intermedius’da sonlanir. Buradan ¢ikan aksonlar ise beyin korteksinde
primer motor sahada sonlanir. Bu sayede hareketlerin daha diizenli yapilmasi saglanmis

olur.
3. Tractus cerebellovestibularis

Nucleus fastigii’den ¢ikan aksonlar, cerebellum’u pedunculus cerebellaris
inferior’dan terk eder ve her iki tarafin nuc. vestibularis lateralis’inde sonlanir. Ayni

taraf ekstensor kaslarina kolaylastirict etki gosteren impulslari tagiyan yoldur.

4. Tractus cerebelloreticularis

Nuclues fastigii’den c¢iktiktan sonra pedunculus cerebellaris superior’dan
cerebellum’u terkeden lifler, aymi tarafin formatio reticularis’indeki nodronlara
baglanirlar. Buradan baglayan liflerde medulla spinalis’in 6n boynuz motor hiicrelerine
girerler ve bdylece medulla spinalis’in motor aktivitesi kontrol edilmis olur (Arinci,

2006; Gokmen, 2008; Snell, 2011).

2.1.5. Cerebellum’un Fonksiyonu

Cerebellum hareketlerin diizgiin, amaca uygun kuvvette ve koordinasyon
igerisinde yapilmasini, statik ve dinamik postiiriin saglanmasini saglar. Ayrica karmasik

motor hareketlerin 6grenilmesini ve diizenlenmesini organize eden bir merkezdir.



Cerebellum istemli hareketlerle ilgili olan beyin korteksinden ¢izgili kaslara giden ilk
impulsu ve bu impuls sonucu kas, kiris, eklem bag1 ve kapsiiliinde olusan proprioseptif
impulsu alir. I¢ kulaktan gelen bas ve boyun pozisyonu ile ilgili proprioseptif duyuyu
alir. Colliculus superior ve colliculus inferior’dan gorme ve isitme ile ilgili lifleri nuclei

pontis araciligi ile alir.

Tim bu duyular cerebellar cortex’de degerlendirilerek, olusan impulslar
purkinje hiicrelerine aktarilir. Purkinje hiicrelerinin aksonlarindan ya dogrudan ya da
cogunlukla ¢ekirdekler araciligi ile efferent yollar baslar. Beyincik hemisferlerinin dig
boliimiinden gelen lifler siklikla nucleus dentatus’ta, i¢ boliimiinden gelen lifler nucleus
globosus ve nucleus emboliformis’de, vermis’ten gelen liflerin bir boliimii nucleus
fastigii’de, bir boliimiide nuc. vestibularis lateralis’te sinaps yapar. Purkinje
hiicrelerinden ¢ikan impulslar sonlandig1 ¢ekirdeklerdeki noronlar iizerine inhibitor etki
yapar. Cerebellar ¢ekirdeklerden ¢ikan efferent bilgi, medulla spinalis ve cerebrum’un
diger boliimlerine dagilmak {izere cerebellum’u terkeder (Arinci, 2006; Gékmen, 2008;

Snell, 2011).

2.2. Stereoloji

Stereoloji, li¢ boyutlu 6rneklerin iki boyutlu kesitlerinden elde edilen verilere
dayanarak, onlarin gercekteki li¢ boyutlu o6zellikleri ile ilgili yorumlar yapilmasim
saglayan bilim dalimin adidir. Bu kesitlerin, herhangi bir yapmnin i¢cinden gecen ve
yapinn bilesenleri ile kesisen diizlemler olduklar1 diisiiniiliirse, ilgili yapinin her bir
bileseni, bu kesitlerde sayisi, biiylikliigli, kapladigi uzunluk, alan ve hacim oraniyla
iliskili bir bicimde izdiisiimler olusturur. Bu izdiistimler ilgili yapinin igerdigi bilesenler
hakkinda bilgi almak tizere kullanilabilir (Howard ve Reed., 1998).

Geleneksel metotlarla i boyutlu yapilarin iki boyutlu kesit goriintiileri
tizerinden degerlendirme yapilmaktadir. Bu c¢aligmalarda {iglincii boyutun ihmal
edilmesi onemli eksikliklere neden olmaktadir (Howard ve Reed., 1998). Stereolojik
metodlar kurallarina uygun bir bicimde uygulandiginda, sistematik hatadan bagimsiz
sonuglar elde edilmesini saglar. Stereolojide, Cavalieri prensibi kullanilarak, goriintii
analiz sistemleriyle birbirine paralel goriintiileri alinabilen, gercekte 3 boyutlu olan her
yapinin tarafsiz ve etkin bir bicimde hacminin hesaplanabilecegi ve gergege yakin bir

degerlendirmenin yapilabilecegi gosterilmistir (Roberts ve ark., 2000; Odac1 ve ark.,



2005). Tarafsiz olmalari nedeniyle bu yontemler kullanilarak hesaplanan degerler,

hesaplayicilar arasinda farkliliklar géstermemektedir (Gundersen ve Jensen, 1987).

Tarafsizhk

Tekrarlayan ol¢iimler sonucu, gittikce gercek degere yaklasan, yani gergek
degerden istatistiksel olarak sapma gostermeyen hesaplamalari tanimlamak igin
kullanilan bir terimdir. Ornekleme ile ¢alisilan bir 6l¢iim yonteminde, dogru sonuglarin
elde edilebilmesi i¢in uygulamanin tarafsiz olmasi gerekir. Calismada kullanilan
yontemden kaynaklanan veya uygulama sirasinda yapilmasi gereken, dogrulanamayan
on kabuller varsa, bu calisma taraflidir. Yani gercek degerden sistematik bir sapma
gosteriyordur. Calisilan yapinin gercek degeri bilinmedigi i¢cin yontemin sebep oldugu
taraflilik ve sonuclarin gercek degerden ne kadar saptigi tespit edilemez. Bu nedenle
calismanin sonuglar1 gergek degerden farkli olabilir (Howard ve Reed, 1998; Odaci ve
ark., 2005).

Rutin uygulamalarda tani i¢in kullanilan BT ve MR goriintiilerinin elde edilme
teknigi incelendiginde tarafsizlik ilkesinin kendiliginden gerceklestigi goriilecektir.
Bilgisayarli tomografi ve MR goriintiileri elde edilirken ilk goriintiiniin baslangig¢
noktas: rastgele secilir ve stereolojinin tarafsizlik mantigi ile ayni temele dayanir.
Gortntiiler elde edilirken ne kadar aralikla (t) alinacagi 6nceden bilinmelidir. Tarama
yapilirken BT ve MR cihazlan ile goriintiiler birbirine paralel olarak elde edilir. Bu
ozellikler topluca gz Oniine alindiginda tarafsizlik ilkesine bagli kalinarak birbirine
paralel elde edilmis ve aralarinda belli bir mesafe bulunan BT ve MR goriintiilerine
Cavalieri prensibi kolayca uygulanabilir (Gunderson ve Jensen, 1987; Howard ve Reed,
1998; Gunderson ve ark., 1999; Canan ve ark., 2002; Odac1 ve ark., 2005).

Etkinlik/Verimlilik

Stereolojik metodlarin 6nemli bir Ozelligi, is ylkiinii azaltarak, istenen
dogrulukta sonuglarin kisa zamanda elde edilmesini saglamaktir. Ornegin, bir organ
igerisindeki hiicrelerin tamamini teker teker saymak, bazi kiiciik organlar i¢in miimkiin
olsa da cogu yapida bu islemi gergeklestirmek oldukca zahmetli bir istir. Boyle bir

yontemle sayimi gerceklestirmek yerine sayimi yapilacak organdan yeterli sayida 6rnek



alarak bu degerleri tespit etmek hem zamandan tasarruf etmemizi hem de rutinde
kullanilmasina imkan saglar (Howard ve Reed, 1998; www.stereoloji.org).

Ornekleme yoluyla herhangi bir niceligi hesaplamak; yapmin tamamimni temsil
edebilecek kiigiik bir parga iizerinde dlgiimler yapmak ve bu 6l¢limiin tiim yapiya olan
oranina bakarak hesaplamaktir. Ornekleme ile yapilan hesaplamalar dogal olarak gercek
degerden belli bir farklilik gosterecektir. Bu farkliliklar istatiksel bakimindan kabul
edilebilir siirlar igerisinde tutuldugu siirece elde edilen hesaplama degeri giivenilir bir
sonug olarak kabul edilir (Howard ve Reed, 1998; www.stereoloji.org).

Bilgisayarli tomografi ve MR goriintiileri lizerinde yapilan Cavalieri hacim
hesaplamalar1 incelendiginde, ilgilenilen yapinin tamamini drnekleyen 8-15 arasindaki
MR ya da BT goriintiisiiniin yeterli oldugu ve sonuglarin ger¢ek degerden istatistiksel
anlamda bir farklilik gostermedigi hesaplanmistir. Yontemin uygulanma siiresinin
ilgilenilen yapinin biiyiikligiine gore 3-7 dk. arasinda olmasi ve diisiik sayida goriintiide
uygulanabilir olmasi, bu ydntemin uygulanmasinda etkinlik prensibinin yerine

getirildigini gostermektedir (Sahin ve ark., 2003).

2.2.1. Cavalieri Prensibi

Incelenen yapi, gevresindeki diger organ veya yapilardan izole edilebilecek
makroskobik yapilanmaya sahipse hacim dogrudan olgiilebilir. Bu gibi durumlarda
hacmi hesaplanmak istenen yap1 ici su dolu dereceli bir silindir i¢ine atilarak, nesnenin
tasirdigi ya da yiiksettigi su miktarindan hacim hesaplanir. Ilgilenilen organm igi
bosluklar igeriyorsa, bdyle yapilarda sivi yer degistirme yontemini uygulamak igin,
organin bosluklarinin girisleri su gecirmeyecek bi¢gimde tikandiktan sonra hacim
Olglimii yapilmalidir. Cogu zaman ilgilendigimiz yap1 gevresindeki bilesenlerden izole
edilemez ya da canliya ait organlarin hacmi suya daldirma ydntemi ile olgiilemez.
Ornegin, cerebellum’un ak maddesi, beyin cekirdekleri gibi yapilari izole ederek
dogrudan bir hacim Olgiimii yapilamaz. Cavaliere prensibi olarak bilinen ve ilk kez
[talyan matematik¢i Bonaventura Cavalieri tarafindan ortaya konmus olan prensip
uygulanabilir (Canan ve ark., 2002).

Cavalieri prensibi ile incelenmek istenen organ ya da organ ic¢ine yerlesmis
belli bir yapmin hacmini 6l¢gmek miimkiindiir. Ozellikle makroskobik calismalarda

dilimleme islemi dogrudan bir bigak ya da kesici aletler yardimi ile yapilir. Alternatif



olarak goriintilleme yontemleri kullanilarak da ilgilenilen yap1 bagtan sona kadar
kapsayacak bicimde kesit gorilintilleri alinarak bu goriintiiler tizerinden hacim
hesaplamalar1 yaygin olarak kullanilmaya baslanmistir (Sahin ve Elfaki, 2012).

Cavalieri yontemi ile nesnenin hacmi hesaplanmak istendiginde, dncelikle yap1
esit kalinlikta ve paralel dilimler halinde bastan sona kadar kesitlere ayrilir. Taraflilig
ortadan kaldirmak igin ilk kesit, kesit kalinligi mesafesindeki herhangi bir noktadan
rastgele olarak alinmal1 ve sistematik olarak esit aralikli kesitler alinacak sekilde isleme
devam edilmelidir. Daha sonra her bir dilimin ayn1 yone bakan yiizeylerinin alanlari
uygun bir yontemle hesaplanir. Tiim dilimlerden elde edilen toplam yiizey alan1 degeri,
ortalama dilim kalinlig1 ile ¢arpilarak, yapinin toplam hacmi tarafsiz olarak hesaplanir.

Cavalieri hacim hesaplama yontemi i¢in ilk asama, ilgilendigimiz bdlgenin iz
diisim alanlarmi hesaplamaktir. Nokta sayim yontemi ve planimetri teknikleri
kullanilarak hacim hesaplamalar1 yapilmaktadir (Sahin ve Ergur 2006; Acer ve ark.,
2008). Nokta sayim yontemi daha az zaman harcanmasi ve daha ucuz bir yontem
olmasina ragmen, planimetri yontemi daha net sonuglar vermesi nedeniyle daha ¢ok
tercih edilmektedir. Nokta sayim yonteminde esit araliklarla ayrilmis noktalardan
olusan nokta dizelerinin basili oldugu, seffaf bir asetat kullanilmaktadir. Bu asetat
ilgilenilen yapinin iizerine rastgele olarak atilir ve ilgilenilen yapiya isabet eden noktalar
sayilarak alan hesaplanir. Bu yontem biiylitme derecesi dogru bir sekilde hesaplandiktan
sonra her tiirlii goriintii lizerinde rahatca uygulanabilmektedir.

Cavalieri yontemi ile hacim hesaplamalarinda, bilgisayar destekli goriintii
analiz cihazlar1 ile planimetrik olarak izdiisim alanlar1 dogrudan ol¢iilmektedir. Bu
yontemde uygun bi¢cimde kalibrasyonu yapilmis mikroskop goriintiileri veya radyolojik
goriintiilerini islemek iizere tasarlanmis bilgisayar yazilimi1 programlar: ile sinirlar
belirlenmis yiizeylerin alanlar1 Slgiilebilir. Osirix, Onis ve ImageJ gibi programlar

planimetrik dlgiimlerde kullanilabilir (Canan ve ark., 2002).

2.2.2. Bilesen Hacim Oranlar1 Hesaplamalar:
Bilesenin hacim orani, herhangi bir yapiyr olusturan alt bilesenlerin tiim

yapinin hacmine (referans hacim) oranini belirlemek amaciyla kullanilir. Y gibi bir



bilesenin referans hacim ic¢indeki hacme orani basit¢e, Y bileseni tarafindan kaplanan

birim hacim miktar1 olarak sdylenebilir ve su sekilde yazilir:
V, (Y,ref) =Y bileseninin hacimi / referans hacim

Omegin, beyincik ak madde hacminin tiim beyincik hacmine oram1 V, (ak
madde, beyincik) seklinde tanimlanir. Hacim orani 1 ile 0 arasinda degisir ve genellikle
(%) olarak ifade edilir. Hacim oranlarim1 hesaplamak amaciyla stereolojide Cavalieri
yonteminde oldugu gibi noktali alan dl¢iim cetvelleri ve bilgisayar destekli goriintii
analiz cihazlar ile planimetrik olarak izdiisiim alanlar1 hesaplanarak iki yapinin birbiri

ile olan hacim iliskisi belirlenir (Basoglu ve ark., 2007; Kalkan ve ark., 2007).

2.2.3. Hata Katsayisinin Hesaplanmasi

Yapilacak olan analizlerde kesit sayisinin ya da kullanilan nokta sikliginin
yeterli olup olmadigini sorgulamak amaciyla verilerin Hata Katsayis1 (HK) hesaplanir.
Hata katsayis1 % 5 ve daha altinda ise yapilan analizlerin dogru olduguna karar verilir.
Gundersen ve Jensen (1987) tarafindan gelistirilen formiil ile HK hesaplanabilir.
Ancak, planimetri yontemi kullaniyorsa hata katsayisi asagidaki formiile gore

hesaplanir (Mazonakis ve ark., 2002):

n -1 1 n n—1 n—2 2
HK = (Zx—li) * 520 (32 Al —4 Zﬂiﬂm + ZAEAHE)]
i=1 i=1 i=1

i=1

Formiildeki ) A kesitlerdeki toplam alani ifade eder. Digerleri sabit rakamlardir.

Hesaplama sonrasinda HK degeri % 5 ve altinda ise 6rnekleme stratejisinin
uygun olduguna karar verilir. Hata katsayisinin % 5’ten biiylik oldugu durumlarda
kullanilan kesit sayisi arttirilarak hedeflenen HK elde edilir (Canan ve ark., 2002; Odaci
ve ark., 2005; Sahin ve Elfaki, 2012).

2.3. Manyetik Rezonans Goriintiilleme
Noronal aktivitenin saptanmasi amaciyla kullanilan c¢esitli norogdriintiileme

teknikleri vardir. Manyetik Rezonans goriintiileme, bilgisayarli tomografi goriintiileme,



pozitron emisyon tomografi (PET), tek foton emisyon tomografi (SPET),
elektroensefalografi (EEG) ve magnetoensefalografi (MEG) kullanilan goriintiileme
yontemlerindendir. Manyetik Rezonans goriintiileme yonteminde BT ve geleneksel X
ray’den farkli olarak radyasyon kullanilmamaktadir. Iyonizan radyasyon riski
olmadigindan c¢ocukluk yas grubunda, hamillerde kullanilabilir ve ayni hastada
defalarca uygulanabilir (Squire ve Novelline, 1985; Misirlioglu ve Yardimci, 2012).

Manyetik Rezonans goriintiileme giiclii bir magnet ve radyo dalgalan ile
viicudun organ ve yapilarmin detayli goriintiilenmesini saglayan giivenli bir tanisal
uygulamadir. Ilk kez Paul Lauterbur tarafindan 1973 yilinda insan viicuduna
uyarlanmistir. 1987 yilinda Charles Dumoulin tarafindan gelistirilen MR-Anjiografi
(MRA) teknikleri ve 1993 yilinda kullanilmaya baslanan fonksiyonel MR uygulamalari,
MRG’yi sadece bir anatomik goriintiileme yontemi olmaktan ¢ikarip fonksiyonel bir
inceleme yontemi sekline doniistiirmiistiir. Gorilintiileme teknikleri genel olarak yapisal
ve fonksiyonel goriintiileme olarak iki kategoride incelenir. Yapisal Manyetik Rezonans
goriintlileme, beyin anatomisini uzaysal ¢Oziiniirlikkte ortaya koyan bir goriintiileme
teknigidir, fonksiyonel Manyetik Rezonans goriintiileme ise anatomik bilginin yaninda
fonksiyonel bilginin de elde edildigi genel bir terimdir (Oyar, 2008; Misirlioglu ve
Yardimci, 2012).

Manyetik Rezonans prensipleri kullanilarak belirli bir zaman igerisinde olusan
beyin aktivasyonu Olgiilerek, beynin haritalanmasi gerceklestirilir. Fonksiyonel MR
goriintiileme ile ilgili caligmalar gorsel olarak bir goriintiiniin takibi veya elin sikilmasi
islemi gibi basit motor gorevler ile ilgili kortikal bolgelerin tayin edilmesi gibi
caligmalardan olusurken, daha kompleks caligmalarda gergeklestirilmektedir (Oyar,
2008).

Manyetik Rezonans goriintiileme, 6zellikle santral sinir sistemi, kas-iskelet
sistemi batin ve pelvis sistemi, bas-boyun olmak iizere insan viicudunun hemen her
yerinde goriintiileme ve patolojik durumlarin teshisi i¢in kullanilmaktadir. Manyetik
Rezonans  goriintiileme insan  viicudunun  yiiksek  kontrast  ¢oziiniirliikte
goriintiilenmesini  saglayan bir gorlintiileme teknigidir. Manyetik Rezonans
goriintiileme’nin yumusak doku ve kontrast ¢oziiniirliigii nedeniyle beynin gri ve beyaz
cevher sinyallerinin birbirinden ayrilmasi ve 0&zellikle beyaz cevher lezyonlarinin

belirlenmesi miimkiin olmustur (Oyar, 2008).



Viicudumuz oncelikli olarak yag ve sudan olusmakta olup, bu olusumlarin
molekiiler yapisinda agirlikli olarak hidrojen atomlar1 yer almaktadir. Viicudumuzun
yaklasik %63’linde yer alan hidrojen atom ¢ekirdekleri MR sinyalinin kaynagin
olusturur. Hidrojen atomlarinin giiclii bir manyetik alan icerisinde kendilerini rezonansa
ugratacak bir radyo frekans dalgasi ile uyarilip titrestirilmesinden elde edilen sinyallerin
gorilintliye doniistiiriilmesi ile radyolojik goriintiiler elde edilir. Hastanin hidrojen
cekirdegindeki protonlar uzayda rastgele yerlesmis kiigiik miknatis g¢ubuklar olarak
diisiiniildiiglinde, hasta o cubuk miknatislar1 hizaya getiren kuvvetli manyetik alana
yerlestirilir. Radyo dalgalarinin titresimi hastadan gegirildiginde miknatislar yerlerinden
saparak siralandiklar1 konuma geri donerken kiicik radyo titresimleri yayarlar.
Protonlarin harekete gectikten sonra tekrar eski hallerine donmeleri icin gereken
frekans, kuvvet ve zaman bir sinyal iiretir. Uretilen bu veriler bir bilgisayar tarafindan
analiz edilir ve goriintii olusturulur. Titresimlerin ardisikligi, protonlarin etkisine maruz
birakilarak tarama parametreleri olarak T1 ve T2 agirlikli goriintiiler elde edilir. Bu
durumda goriintii kontrastinda goriintiiyli vurgulayan ve farkliliklar1 vurgulayan degisik
doku karakteristikleri gibi farkliliklar ortaya ¢ikar. T1 agirlikli goriintiilerin ¢ogunda
stvilar koyu, yaglar parlak gorilir. T2 agirlikli goriintilerde sivi parlak goriintii
verirken yag ara bir sinyal gosterir (Oyar, 2008; Grays, 2011).

Manyetik Rezonans ve BT goriintiileme gibi radyolojik tetkikler gergekte 3
boyutlu olan yapilarin 2 boyutlu goriintiilerinin elde edildigi goriintiileme yontemleridir.
Manyetik Rezonans goriintiileme yontemi gibi radyolojik goriintiileme yontemleri ile
ilgilenilen yapmin gercek hacim veya bilesen hacim degisikleri degerlendirilir.
Degerlendirmeler sonucunda ilgilenilen yapinin normal olup olmadigina ve
uygulanacak tedavinin plan ve sonuglaria yonelik degerlendirmeler yapilir. Radyolojik
tetkik goriintiilerinin klinikte kullanimi ile bir hastanin tedavi 6ncesi ve tedavi sonrasi
cekilen radyograflarinin karsilastirilmasi miimkiindiir. Ornegin, radyoterapi tedavisi
alan beyin tiimorlii bir hastanin tedavisinde, tiimoriin tedavi 6ncesi ve tedavi sonrasi
hacim degerinin sayisal verilerle ortaya konmasi miimkiimdir (Gong ve ark.,2004;

Odaci ve ark., 2005).



3. MATERYAL METOD

Sunulan ¢alismada MR goriintiileri tizerinden cerebellum ak ve gri madde
hacmi ve hacim oranlar1 stereolojik yontemlerden Cavalieri prensibi kullanilarak
hesaplanmistir. Calismada saglikli goniillilere ait ve 1 mm kalinliginda ardisik
kesitlerden olusan beyin MR goriintiileri, OsiriX programiyla sagittal yonelimde
Talairach diizlemine uygun 1mm kesitlere doniistiiriildii. Goriintiiler ImageJ programi
ile 1/5 oraninda sistematik rasgele Orneklendi. Cerebellum hacmi ile ak madde
hacimleri yar1 otomatik planimetri yontemi ile 6lgiildii.

Calismada kullanilan gériintii bankas1 Gezira Universitesi tarafindan onaylandi.
Goriintiiler alman onay ¢ergevesinde National Ribat Universitesi Radyoloji Anabilim
Dalina ait radyolojik goriintilleme merkezinde yapildi. Sizofren ve saglikli bireylerin
beyinlerinin morfolojik olarak karsilastirilmasi iizerine kurgulanmis olan bir arastirma
calismasinin saglikli kontrol grubundan rastgele 6rnekleme yontemi ile secilen 42 erkek
ve 28 kadin goniilliiye ait toplam 70 bireyin MR gdriintiisii ¢alismada kullanildi.

Yapisal MR goriintiileri Siemens 1,5 Tesla Magnetom Avanto Vision Sistem
cihaz1 kullanilarak elde edildi. T1 agirlikli ve iic boyutlu goriintiiller Magnetization
Prepared Rapid Acquization (MP-RA) protokolii kullanilarak elde edildi. Kullanilan
protokol kisa siirede yiiksek kalitede ak ve gri madde ayrimi saglayan bir protokoldii.
Koronal yonelimde ve Imm kalinhiginda elde edilen ardisik kesit goriintiileri su
parametreler kullanilarak elde edildi: goriintii alan1 512 X 384mm, TR=1657ms,
TE=2,95ms, band genisligi 180Hz/piksel, flip acist 15°, ECHO spacing=7,5ms, faz
¢ozinlirligi=%100, kesit ¢ozinlrligii=%50 ve goriintiileme siiresi= 5 dakika 18
saniye.

Koronal yonelimde beyin MR goriintiileri DICOM formatinda kaydedildi
(Sekil 4). DICOM formath goriintiilerin diizenlenmesi ve islenmesi amaciyla
¢Oziiniirliik kalitesi iyi olan, Macintosh igletim sistemi altinda ¢alisan OsiriX programi
tercih edildi. CD ortaminda temin edilen MR goriintiileri OsiriX programinin arsivine
eklendi. Bu igslem OsiriX programinin File > Import > Import files sekmesinden BT

gorlntiilerinin icerdigi dosya secildi ve arsivleme islemi tamamlandi.



Sekil 4. DICOM formatinda koronal yonelimde beyin kaydedilmis MR goriintiisii

Cerebellum toplam hacmi ve ak madde hacmini hesaplamak i¢in koronal
goriintiiler sagittal yonelime ¢evrildi. Bu islem i¢in OsiriX programinin “3D Viewer >
3DMPR” sekmesi kullanildi. Goriintiiler Talairach (commisure anterior ve posterior’un
transvers diizleme paralel, sagital ve koronal diizlemin bu hatta dik oldugu) yonelime

getirildi (Sekil 5).
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Sekil 5. Koronal goriintiilerin Talairach yonelime getirilmesi

768 X 768 goriintii alanina sahip sagittal yonelimde ve 1mm kalinliginda
ardisik kesit goriintiileri elde edildi (Sekil 6). Bu islem i¢in sagittal goériintii se¢ildi ve
“File > Export > Export to DICOM file(s)” sekmesi kullanilarak goriintii yeniden

arsivlendi.

Sekil 6. Talairach yonelimde koronal ve 1mm kalinliginda MR goriintiisii



OsiriX programinda arsivlenen sagittal yonelimli Imm kalinligindaki goriintii
serileri, hacim Ol¢limiiniin ImageJ programinda yapilacak olmasindan dolayr OsiriX
programi arsivinden disariya ¢ikartildi. Bu islem i¢in disa aktarilacak goriintiiniin MPR
serisi secildi. “File > Export > Export to DICOM file(s)” sekmesinden disa aktarilacak
bir klasor secildi ve bu klasore aktarildi. Bu asamadan sonra goriintiiler bilgisayar
ortaminda Windows igletim sistemi altinda yapildi.

Hacim o6l¢iim islemleri i¢in stereolojik ¢aligmalara uygun olan ImageJ
programi kullanildi. Amerika Birlesik Devletleri, Ulusal Saglik Enstitiileri tarafindan
ticretsiz olarak dagitilan ImageJ programi iicretsiz olarak internetten temin edildi.
ImagelJ programi bilgisayarin isletim sistemi goz oniine alinarak uygun sekilde kuruldu.
Sagittal yonelimde disa aktarilan goriintii serilerini iceren klasorler, hacim Ol¢iimii

yapilmak iizere ImagelJ programinda “siiriikle birak” yontemi ile acildi (Sekil 7).
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Sekil 7. Imagel programinda agilmis bir sagittal MR goriintiisii

Median goriintiiye gidildikten sonra, Programin Image > Adjust > Window /
Level sekmesine gidilerek otomatik kontrast ayari yapildi. Sagittal goriintii serileri
ortalama 170-190 kesit goriintiisiinden olugmaktaydi. Stereolojinin etkinlik prensibi

geregi hacim Ol¢limiiniin daha hizli yapilabilmesi i¢in goriintii serilerinden sistematik



rastgele ornekleme yapildi. Yapilan pilot ¢alisma neticesinde 1/5 oraninda 6rnekleme
yapilmasina karar verildi. Bunun i¢in ImageJ programinin Image > Stacks > Tools >
Reduce sekmesi kullanildi. Bu sekmede yer alan “Reduce Size” degerine 5 rakami
yazild1 ve program kesit miktarini 1/5 oraninda otomatik olarak azaltti.

Kesit orneklemesi yapilmis olan goriintii serisi yari otomatik planimetri
yontemi kullanilarak analiz edildi. Bu maksatla goriintiileri bir tarafindan diger tarafina
cerebellum’un tiim kesit ylizey alan1 ve ak madde kesit ylizey alan1 program yardimi ile
hesaplandi. ImagelJ programinin “Image > Zoom > In” sekmesi kullanilarak uygun
biiylitmede sagittal cerebellum kesit yiizeyi goriintiilendi. “Image > Adjust > Threshold”
sekmesi kullanilarak cerebellumun tiim kesit yilizeyini kapsayacak bir alan isaretlemesi
yapildi. Programin “Poligon Selection” diigmesine basilarak cerebellumun’un etrafi
diger yapilardan ayrilacak sekilde kabaca ¢izildi (Sekil 8). Programin “Analyze >

Measure” komutu ile cerebellum’un her bir kesitteki iz diisiim alan1 6l¢iildi.
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Sekil 8. Image] programinda cerebellum’un threshold yontemi ile isaretlenmesi ve kesit yiizey alaninin

siirlandirilmasi

Ak madde hacminin hesaplanmasi i¢in programin “Image > Adjust >
Threshold” sekmesi kullanilarak ak madde kesit yiizeyini kapsayacak bir alan
isaretlemesi yapildi. Programin “Analyze > Measure” komutu ile her bir kesitteki ak

madde iz diistim alan1 6l¢iildii (Sekil 9).
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Sekil 9. ImageJ programinda ak maddenin threshold yontemi ile isaretlenmesi ve kesit ylizey alaninin

smirlandirilmasi

Programdan elde edilen mm? cinsinden kesit yiizey alanlari Excel dosyasina

aktarilarak kaydedildi ve muhafaza edildi (Tablo 2).

Tablo 2. Bir bireyin cerebellum’una ait kesitin iz diisiim alanlarin1 gosterir tablo

Kesit 1 2 3 4 5 6 7 8 9 10 11 12 13

Beyincik 59 334 798 1294 1688 1965 1579 1695 1958 1656 1245 563 152

Ak

Madde 11 193 476 831 1003 480 972 938 673 250 28 - -

Excel’de hazirlanmis sablonlar kullanilarak kesit yiizey alanlarinin toplamu ile
kesit kalinliklar1 carpilmak suretiyle toplam beyincik hacmi ve ak madde hacmi
Cavalieri yontemine gore hesaplandi (Sekil 10). Islem asagidaki formiil ile ifade

edilebilir:

Vs =228 Xt



Ve, ilgilendigimiz yapmin toplam hacmini; 2 tim kesitlerdeki yapinin
izdiistimlerinin toplam ylizey alanini; t ise ortalama kesit veya dilim kalinligin belirtir.

Calismada 1/5 oraninda kesit 6rneklemesi yapildigindan kesit kalinlig1 0,5 cm olarak

kullanildi.

Sekil 10. Cerebellum ve ak madde hacim ve hacim oranlari ile hata katsayilarinin hesaplanmasi igin

A A B C

1 Hasta adi CNTMO1

2 Tarih 28.03.2012

3 | Kesit Kalinhigi (mm) 1 1

4 Aralik (mm) 4 4

5 Kesit Beyincik |Akmadde

6 1 29 11

7 2 208 77

8 3 334 193

9 4 557 327

10 < 798 476

11 6 1194 667

12 7 1294 831

13 8 1493 990

14 9 1688 1003

15 10 1836 755

16 11 1965 480

17 12 1767 477

18 13 1579 972

19 14 1501 912

20 15 1695 938

21 16 1918 795

22 1/ 1958 673

23 18 1804 434

24 19 1656 250

25 20 1493 137

26 21 1245 28

27 22 876 2

28 23 563

29 24 276

30 25 152

31 26

32 27

33 28

34 29

35 30

36 Toplam 29879 11428
37 | HataKatsayisi 05 1,6

38 | Hacim cm® 1494 57.1

39 | % Oranlar 61,8 38,25

hazirlanmis Excel sablonu




Beyincik ak maddesinin tiim beyincik hacmine orani ise asagidaki formiil ile
belirlendi:

Vvbeyincik= (ak madde hacmi/toplam beyincik hacmi) X 100

Elde edilen deger yiizde cinsinden ak maddenin oranimi ifade etmektedir. Ak
maddenin hacim oranmi 100 rakamindan ¢ikarmak suretiyle de gri madde hacim orani

tespit edildi.

Cerebellum toplam hacmi ve ak madde hacmi hesaplamalarinin hata katsayisi
(HK) Mazonakis ve ark. (2002), belirttigi formiil kullanilarak hesaplandi.

Calismadan elde edilen hacim degerleri ve calismaya dahil edilen bireylerin
yas, boy, kilo ve viicut kitle endeksi degerlerinin ortalama, en diisiik, en yiiksek ve
standart sapma degerleri istatistiksel analize yonelik bir bilgisayar programi (SPSS
15.0) kullanilarak analiz edildi.

Elde edilen veriler Statistical Package for the Social Sciences (SPSS) (V.15)
istatistik programinda degerlendirilerek, bayan ve erkek bireylerin cerebellum hacmi, ak
ve gri madde hacmi ile cerebellum ak ve gri madde hacim oranlarinin ortalama degerleri
hesaplandi. Gruptaki birey sayist 30’un lizerinde oldugundan Parametrik testlerden,
Independent Sample Test (Bagimsiz gruplar t-testi) ile cerebellum’un gri madde ve
beyaz madde hacimleri arasinda cinsiyetler yoniinden fark olmadigi tespit edildi.
Cerebellum hacmi, ak madde hacmi, gri madde hacim orani, ak madde hacim orani, yas,
boy, agirlik, Viicut Kitle Indeksi (VKI) arasindaki iliski Pearson Correlation Testi ile
analiz edildi. Erkek ve kadin bireyler arasinda cerebellum hacmi, ak madde hacmi, gri
madde hacim orani, ak madde hacim orani, yas, boy, agirlik ve VKI degerleri arasindaki
farkliliklar Analysis of Variance (ANOVA) testi kullanilarak analiz edildi. P degerinin
0,05’den kiigiik olmas1 durumunda istatistiksel fark olduguna karar verildi. Veriler,

ortalama + standart sapma seklinde ifade edildi.



4. BULGULAR

Bu calismada 42 erkek ve 28 kadin olmak iizere toplam 70 bireye ait goriintii

kullantlmistir.

Bu goriintiilerden elde dilen verilerin ortalama degerleri ve istatistiksel
sonugclari iki boliimde aktarildi. Birinci boliimde bireylerin tanimlayict bilgileri sunuldu.
Bu cergevede bireylerin yas, boy, kilo ve viicut kitle indeksi degerlerinin ortalama, en
diisiik, en yliksek ve standart sapma (SS) degerleri hesaplandi. Bulunan degerlerin erkek
ve kadin bireyler arasinda istatistiksel karsilastirmasi yapildi. Ikinci boliimde bireylerin
cerebellum, ak ve gri madde hacimleri ile ak ve gri madde hacim oranlar istatistiksel
olarak incelendi. Cerebelluma ait hacim ve hacim orani degerleri kadin ve erkekler
arasinda karsilastirildi. Ayrica, bireylerin tanimlayici 6zellikleri ile hacim ve hacim

oranlar1 arasindaki iligki analiz edildi.

4.1. Bireylerin Tamimlayic1 Bilgileri

Calismaya dahil edilen erkek bireylerin yas ortalamasinin (ortalama#SS)
28,79+6,03 yil, kadinlarin yas ortalamasinin ise 29,87+6,48 yil oldugu tespit edildi.
Kadmlarin yas ortalamasinin erkeklerinkinden fazla olmasina ragmen erkek ve kadin
bireylerin yas ortalamalari arasinda istatistiki bir fark gézlenmedi (p>0,05; Sekil 11).

Gruplarin tanimlayici 6zelliklerinin detaylar1 Tablo 3°de verilmistir.



Tablo 3. Calismadaki bireylerin tanimlayici bilgileri (VKI: Viicut kiitle indeksi)

N  Minimum Maksimum Ortalama Standart Sapma P
Erkek 42 20 40 28,79 6,03
Yas (y1l) 0,673
Kadin 28 20 40 29,87 6,48
Erkek 42 156 190 174,50 6,70
Boy (cm) 0,000
Kadin 28 145 172 160,64 6,84
] Erkek 42 52 100 73,52 11,34
Kilo (kg) 0,004
Kadm 28 44 96 69,14 13,35
VKI Erkek 42 17,9 29,9 24,11 3,27 028
,284
(kg/m?)  Kadm 28 183 37 26,73 4,47
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Sekil 11. Erkek ve kadin bireylerin yas ortalamalar1




Erkeklerin boy ortalamasinin 174,50+6,70 cm, kadinlarin boy ortalamasinin ise
160,64+6,84 cm oldugu tespit edildi (Tablo 3; Sekil 12). Erkeklerin kadinlara gore daha
uzun oldugu gozlendi (p<0,05).
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Sekil 12. Erkek ve kadin bireylerin boy ortalamalari

Erkeklerin ve kadinlarin viicut agirliklarinin 73,52+11,34 kg ve 69,14+13,35kg
oldugu tespit edildi (Tablo 3; Sekil 13). Erkeklerin kadinlara gore istatistiksel olarak
daha agir oldugu bulundu (p<0,05).
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Sekil 13. Erkek ve kadin bireylerin agirlik ortalamalari

Son olarak viicut kitle indekslerine gore cinsiyetler incelendiginde erkeklerin
viicut kitle indeksi ortalama 24,11+3,27 ve kadinlarin viicut kitle indeksi ortalama
26,73+4,47 olarak tespit edildi (Tablo 3; Sekil 14). Gruplar arasindaki fark istatistiki

olarak anlamli bir seviyeye ulagsmadi (p>0,05).
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Sekil 14. Erkek ve kadin bireylerin viicut kitle indeksi (VKI)

4.2. Cerebellum ve Ak Madde Hacimleri ve Hacim Oranlari

Calismadaki tiim bireylerin ortalama cerebellum hacmi 144,78+12,30 em®
olarak hesap edildi. Erkeklerde cerebellum hacmi ortalama 149,75+12,09 cm® olarak

% olarak

hesaplandi. Kadinlarda ise cerebellum hacmi ortalama 137,30+£8,28 cm
hesapland1 (Tablo 4; Sekil 15). Erkeklerin cerebellum hacminin kadinlarinkinden

istatistiksel olarak anlamli derecede biiyiik oldugu belirlendi (p<0,05).



Tablo 4. Cerebellum ve ak madde hacimlerinin (cm®) erkek ve kadinlarda olgiilen degerleri ve

istatistiksel karsilagtirilmasi

Ortalama Std. Sapma P
Cerebellum Hacmi Erkek 149,75 12,09
Kadin 137,30 8,28 0,000
Toplam 144,78 12,30
Ak Madde Hacmi Erkek 40,48 8,12
Kadin 50,41 13,02 0,000
Toplam 44,45 11,38
Gri Madde Hacmi Erkek 109,26 11,95
Kadin 86,89 12,40 0,000
Toplam 100,31 16,34
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Sekil 15. Erkek ve kadin bireylerin cerebellum hacmi ortalamalar (cm®)



Tiim bireylerin ortalama ak madde hacmi 44,45+11,38 cm® olarak hesap edildi.
Erkeklerde ak madde hacmi ortalama 40,48+8,12 cm?® ve kadinlarin ak madde hacmi
ortalama 50,41+13,02 cm® olarak tespit edildi (Tablo 4; Sekil 16). Kadinlarin ak madde
hacminin erkeklerinkinden istatistiki anlamda biiyiik oldugu bulundu (p<0,05).
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Sekil 16. Erkek ve kadin bireylerin ak madde hacmi ortalamalari (cm®)

Tiim bireylerin ortalama gri madde hacmi 100,31+16,34 olarak hesap edildi.
Erkeklerde gri madde hacmi ortalama 109,26+£11,95 olarak hesaplandi. Kadinlarda ise
gri madde hacmi ortalama 86,89+12,40 olarak hesaplandi. Erkeklerin gri madde
hacminin kadinlarin gri madde hacminden biiyiik oldugu bulundu (Tablo 4; p<0,05).



Tiim bireylerin ortalama gri madde hacim oram1 % 69,10+8,31 olarak hesap

edildi. Erkeklerde gri madde hacim orani ortalama % 72,93+5,12 olarak hesaplandi.

Kadinlarda ise gri madde hacim orani ortalama % 63,37+8,92 olarak hesaplandi (Tablo

5; Sekil 17). Gruplar arasindaki oransal farkin istatistiki olarak anlamli oldugu bulundu

(p<0,05).

Tablo 5. Gri madde ve ak madde hacim oranlarinin (%) erkek ve kadinlarda oSlgiilen degerleri ve

istatistiksel karsilagtirilmasi

Ortalama Std. Sapma P
Erkek 72,93 5,12 0,000
Gri Madde Hacim Orani Kadm 63,37 8,92
Toplam 69,10 8,31
Erkek 27,06 5,12 0,000
Ak Madde Hacim Orani Kadin 36,63 8,92
Toplam 30,90 8,31
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Sekil 17. Erkek ve kadin bireylerin gri madde hacim orani ortalamalari (%)

Calismadaki tiim bireylerin ortalama ak madde hacim oram1 % 30,90+ 8,31
olarak hesaplandi. Erkeklerde ortalama ak madde hacim orant % 27,06+£5,12 ve
kadinlarda ortalama ak madde hacim oranit % 36,63+8,92 olarak hesaplandi (Tablo 5;
Sekil 18). Gruplar arasindaki oransal farkin istatistiki olarak anlamli oldugu bulundu

(p<0,05).
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Sekil 18. Erkek ve kadin bireylerin ak madde hacim orani ortalamalar1 (%)

Tablo 6. Cerebellum ve ak madde hacimleri (cm?) ile yas, boy, agirlik, VKI degerleri korelasyon tablosu

Yas (Yil) Boy (cm) Agirhk(kg) VKI

Cerebellum Pearson Correlation  -0,146 0,461 0,296 -0,020
Hacmi Sig. (2-tailed) 0,227 0,000 0,013 0,871
N 70 70 70 70
Pearson Correlation  -0,067 -0,058 0,026 0,082
Ak Madde Sig. (2-tailed) 0,580 0,633 0,832 0,498
Hacmi N 70 70 70 70
Pearson Correlation  -0,063 0,387 0,205 -0,072
Gri Madde Sig. (2-tailed) 0,604 0,001 0,089 0,555
Hacmi N 70 70 70 70

P<0,05=>*, p= 0,01=>**



Cerebellum hacmi ile boy arasinda pozitif yonde orta diizeyde bir iligki goriildii

(p<0,01; r= 0,461). Cerebellum hacmi ile agirlik arasinda pozitif yonde diisiik diizeyde

bir korelasyon gozlendi (p<0,05; r= 0,296). Gri madde hacmi ile boy arasinda pozitif

yonde orta diizeyde iliski goriildii (p<0,01; = 0,387). Diger yapilar ile yas, boy, agirlik

ve VKI arasinda anlamli bir korelasyona rastlanmadi (Tablo 6).

Tablo 7. Gri ve ak madde hacim oranlari ile yas, boy, agirlik, VKI degerleri korelasyon tablosu

Yas (Yil) Boy (cm) Agirhk(kg) VKI
Gri Madde Pearson Correlation 0,033 0,191 0,056 -0,091
Hacim Orani Sig. (2-tailed) 0,789 0,113 0,644 0,452
N 70 70 70 70
Pearson Correlation -0,033 -0,191 -0,056 0,091
Ak Madde Sig. (2-tailed) 0,789 0,113 0,644 0,452
Hacim Oram N 70 70 70 70

p<0,05=>*, p= 0,01=>**

Gri madde ve ak madde hacim orani ile yas, boy, agirlik ve VKI degerleri

arasinda yapilan korelasyon analizinde hicbir parametre arasinda anlamli bir iliski

gbzlenmedi (Tablo 7).

Tablo 8. Cerebellum ve ak madde hacimleri (cm®) ile gri ve ak madde hacim oranlar1 korelasyon tablosu

Ak Madde Gri Madde Gri Madde Ak Madde
Hacmi Hacmi Hacim Oran1  Hacim Orani
Cerebellum Pearson Correlation 0,049 0,718™ 0,263 -0,263"
Hacmi Sig. (2-tailed) 0,685 0,000 0,028 0,028
N 70 70 70 70
Pearson Correlation -0,659™ -0,948™ 0,948™
ﬁ‘;c'\r:']?dde Sig. (2-tailed) 0,000 000 000
N 70 70 70
) Pearson Correlation 0,858™ -0,858™
ﬁ;‘cm'vi'adde Sig. (2-tailed) 0,000 0,000
N 70 70

p<0,05=>* p=0,01=>**

Cerebellum hacmi ile gri madde hacmi arasinda pozitif yonde yiiksek diizeyde

korelasyon gozlendi (p<0,01; r= 0,718). Cerebellum hacmi ile gri madde hacim orani



arasinda pozitif yonde diisiik diizeyde korelasyon gozlendi (p<0,05; r= 0,263).
Cerebellum hacmi ile ak madde hacim orani arasinda negatif yonde diisiik diizeyde

iliski gozlendi (p<0,05; r=-0,263; Tablo 8).

Ak madde hacmi ile gri madde hacmi arasinda negatif yonde orta diizeyde
korelasyon gozlendi (p<0,01; r= -0,659). Ak madde hacmi ile gri madde hacim orami
arasinda negatif yonde yiiksek diizeyde korelasyon gozlendi (p<0,01; r= -0,948). Ak
madde hacmi ile ak madde hacim orani arasinda pozitif yonde yiiksek diizeyde
korelasyon gozlendi (p<0,01; r= 0,948; Tablo 8).

Gri madde hacmi ile gri madde hacim orami arasinda pozitif yonde yiiksek
diizeyde korelasyon gozlendi (p<0,01; r= 0,858). Gri madde hacmi ile ak madde hacim
orani arasinda negatif yonde yiiksek diizeyde korelasyon gozlendi (p<0,01; r= -0,858;
Tablo 8).

4.3. Hata Katsayis1 Hesaplamalari

Cavalieri prensibinde kullanilan hata katsayis1 hesaplamasina gore cerebellum
hacminin erkek ve kadinlardaki 6l¢iimii sonucunda ortalama hata katsayisi (%) sirasiyla
1,87; 1,56, ak madde hacim o6l¢limleri sonucunda erkek ve kadinlarda ortalama hata
katsayist 1,25; 2,46 olarak hesap edildi. Gri madde hacim Ol¢limlerine gore ortalama
hata katsayis1 erkeklerde 1,84, kadinlarda ise 2,34 olarak hesaplandi. Gri madde ve ak
madde hacim orani hesaplandiginda hata katsayisi erkek bireylerde ortalama 0,78, kadin

bireylerde ise 1,69 olarak tespit edildi (Tablo 9).

Yapilan caligmada her bir bireyin cerebellum hacmi ve ak madde hacminin

hesaplanmasi i¢in gecen siire ortalama 23 dakika olarak tespit edilmistir.

Tablo 9. Cavalieri prensibi ile yapilan hacim hesaplamasinin ortalama hata katsayilart

Cerebellum Ak Madde Gri Madde Eil Madde - Madde
Hacim Orani Hacim Orani
Erkek 1,87 1,25 1,84 0,78 0,78

Kadin 1,56 2,46 2,34 1,69 1,69




5. TARTISMA

Insanin dogumuyla baslayan ve hayat siireci boyunca yaslanmayla beraber
organizmada c¢esitli anatomik ve fizyolojik degisimler goriilmektedir. Bu baglamda
Cerebellum’da da muhtelif degisiklikler gozlenir. Bu hacimsel ve anatomik degisimler
bir¢ok arastiricinin ilgisini ¢ekmektedir. Cerebellum hacminin hesaplanmasi, sonradan
meydana gelebilecek biiyiikliik farkliliklarin dogru degerlendirilmesi ve degisimlerin
hesaplanmasi agisindan onemli olabilir. Cerebral ve cerebellar hacim degerlendirmeleri
bircok hastalik i¢in ¢ocuk ve yetiskinlerde énemlidir. Yeni doganda beyin hacmini ve
ylizey alanmin hesaplanmasi olusabilmesi muhtemel santral sistemi hastaliklarinin
erken donemde teshis edilmesi agisindan onemlidir (Ozcelik ve ark., 2013). Cerebellar
atrofi yasla birlikte goriilebildigi gibi bazi patolojik rahatsizliklar, sizofreni, Alzheimer
hastaligi, epilepsi, alkolizm, yiiksek kolesterol, diyabet gibi patolojiler de cerebellar
morfolojide degisimlere neden olabilmektedir (Bas ve ark., 2009; Hoogendam ve ark.,
2012).

Insan beyninin ¢esitli bélgeleri stereolojik olarak incelendiginde, bu yapilarin
toplam hacmi ve hacim oranlarinin arastirildigi bir ¢ok calisma mevcuttur (Sahin ve
Elfaki, 2012; Elfaki ve ark., 2013). Mevcut calismalarda toplam beyin hacmi, hacim
oranlari, beyaz ve gri cevher hacimleri Olclilmiistiir. Literatliirde cerebrum hacminin
cinsiyete baglh farkliliklarinin incelendigi ¢alismalar da bulunmaktadir (Nopoulos ve

ark., 2000; Allen ve ark., 2003; Ekinci ve ark., 2008).

Bilimin gelismesiyle birlikte ylizyillardir siiregelen bir tartisma olan erkek ve
kadinlar arasindaki farkliliklar nelerdir sorusuna yapilan ¢calismalar dogrultusunda azda
olsa cevap verilebilmektedir. Erkek ve kadinlar arasindaki farkli davranig, his ve
diisiinceler i¢in bireylerin anatomik, fizyolojik, genetik ve hormonal farkliliklarini m1
diistinmeliyiz? Bu sorudan yola ¢ikarak, sunulan bu ¢alisma arastirmacilara ileride
yapacaklar1 bu yondeki ¢aligmalarda nicel degerlerimizin kullanilmasi agisindan fayda
saglayabilir. Cerebellum hacminin cinsiyete bagl farkliliklarini inceleyen calismalar
literatiirde mevcuttur (Luft ve ark., 1999; Ekinci ve ark., 2008; Gocmen-Mas N ve ark.,
2009; Pangelinan ve ark., 2011; Hoogendam ve ark., 2012). Ancak, hacim oranlarinin
cinsiyetler arasindaki farkini inceleyen bir ¢alismaya rastlanmadi. Ayrica, bu ¢alismada

Afrika rkina ait bireylerin cerebellum hacmi ve hacim oranlar1 erkek ve kadinlarda



incelenmistir. Literatiirde Afrika irkina ait bireylerde cerebellum yapilarinin hacim ve
hacim oranlarin1 inceleyen bir calismaya rastlayamadiginizdan bu calisma O6nem

tasimaktadir.

Calismamiza 20-40 yas arasi bireyler dahil edilmis olup, dahil edilen erkek ve
kadin bireylerin yas ortalamalari arasinda istatistiksel anlamda fark yoktu. Beyin
dokusunun yasa bagli olarak hacminde azalma goriilmesi nedeniyle (Elfaki ve ark.,
2013) tasarlanan g¢aligmalarda, cinsiyetlerin yaslarinin birbirine yakin olusu verilerin

giivenilirligi agisindan 6nemlidir.

Calismamiza dahil edilen erkek bireylerin kadinlardan %7,94 daha uzun
oldugu tespit edildi. Erkeklerin kadinlardan uzun olmasi biyolojik bir ger¢ek olup, bu
durum tiim wrklarda goriilebilmektedir. Erkeklerin kadinlara gore %35,96 daha agir
oldugu bulundu. Bu durum erkeklerde boy ile de orantili olarak degisebilen bir
parametre olup, biyolojik bir gercektir. Viicut kitle indekslerine gore cinsiyetler
incelendiginde, erkek ve kadin bireylerin ortalamalar1 arasinda istatistiksel olarak
onemli farlilik gbézlenmedi. Viicut kitle indeksi bireylerin agirlik ve boy ol¢iimlerinin
kullanilmastyla hesaplanan bir deger olup, cinsiyetler arasinda viicut biiytikliigiine bagl

farkliliklar1 ifade etmek i¢in 6nemli bir parametredir.

Literatiirde cerebellum hacminin arastirildigi, kadin ve erkeklerdeki
farkliliklarin  belirlendigi c¢alismalar da mevcuttur. Bu c¢alismalardan bazilarinda
cerebellum hacminin erkeklerde kadinlara gore daha fazla oldugu bulunmustur (Raz ve
ark., 1998; Luft ve ark., 1999; Rhyu ve ark.,, 1999; Pangelinan ve ark., 2011;
Hoogendam ve ark., 2012). Cerebellum hacmini 6lgen baz1 ¢alismalarda ise erkek ve
kadin cerebellum hacimleri arasinda bir fark bulunmamistir (Luft ve ark., 1998;
Nopoulos ve ark., 2000; Ekinci ve ark., 2008). Fark olmadig1 yoniindeki ¢aligmalar
erkek ve kadin gruplarinin viicut agirliginin birbirine yakin olmasi durumunda daha

belirgin olabilir.

Sunulan c¢alismada erkeklerde cerebellum hacmi ortalama 149,75 cm®,

kadinlarda ise cerebellum hacmi ortalama 137,30 cm® olarak hesaplandi. Erkeklerin
cerebellum hacminin kadinlarinkinden %8,31 daha biiyiik oldugu belirlendi. Tim

bireylerin ortalama gri madde hacim oranm1 % 69,10 olarak hesap edildi. Erkeklerde gri



madde hacim orani ortalama % 72,93 ve kadinlarda ise ortalama % 63,37 olarak
hesaplandi. Calismamiz literatiir ile Ortligmekte olup, birey sayisinin az olmasi gibi
nedenler, 1rksal farkliliklar, bireylerde bulunmasi muhtemel teshis edilememis olan
rahatsizliklar, yapilan ¢alismalarda farkli sonuglar ¢ikmasina neden olabilmektedir (Raz
ve ark., 1998; Luft ve ark., 1999; Rhyu ve ark., 1999; Pangelinan ve ark., 2011;
Hoogendam ve ark., 2012).

Hoogendam ve ark. (2012) yaptiklarn calismada, 3962 bireyin MR
goriintiilerinin incelenmesi sonucunda yas, cinsiyet, kardiyovaskiiler risk faktorleri ve
cerebellum’da enfarktiisiin bulunmasi durumunda, bu faktorlerin cerebellar hacmi ne
derecede etkiledigi ve bu farkliklarin cerebellar hacimle iliskisini arastirdilar. Yapilan
calismada toplam cerebellum hacmi erkeklerde ortalama 129,7 cm® ve kadinlarda 126,2
cm® olarak tespit edilmistir. Gri madde hacmini erkeklerde ortalama 104,8 cm?® ve
kadmnlarda 101,0 cm®olarak tespit edilmistir. Ortalama cerebellar hacmin erkeklerde
kadinlara oranlara daha fazla oldugu tespit edilmistir. Artan yas ile orantili olarak
cerebellar ve cerebral hacmin azaldig1 gézlenmistir. Artan yas ile cerebellar hacimdeki
azalma her yil ortalama 0,35 ml olarak bulunmustur. Yiiksek glikoz seviyesi ve diisiik
HDL kolestorel seviyesi ile cerebral ve cereballar hacim arasinda baglanti oldugu
goriilmistiir. Hizli yiikselen glukoz seviyesi ve diisiik HDL kolestorol seviyesi ile
cerebellar hacim arasinda baglanti goriiliirken, cerebrum arasinda baglanti
gorilmemigstir. Sigara igme ve diisiik kan basinci arasinda cerebellumla baglanti
goriilmezken cerebrum ile baglanti goriilmiistiir. Cerebellar hacim ile diyabet ve
kolesterol seviyeleri arasindaki iliskiye dair daha oOnce yapilan bir ¢alisma
bulunmamaktadir. Bu ¢alisma ayn1 zamanda cerebrumdaki enfarktiis veya beyaz madde
hacminde azalmanin cerebellum hacmini etkileyebilecegi sonucuna ulagmistir
(Hoogendam ve ark., 2012). Rhyu ve ark. (1999) yaptiklar1 calismada kadinlarin
cerebellum hacmi ortalama 115,38 cm?®, erkeklerde ise ortalama 126,01 cm® oldugu
hesap edilmistir ve erkeklerin cerebellum hacminin kadinlardan biiylik oldugu tespit

edilmistir.

Ekinci ve ark. (2008) 12 erkek ve 12 kadin bireyin MR goriintiileri iizerinden,
nokta sayim yontemi kullanarak, cerebellum hacmini hesaplamislar ve cerebellum

hacmini erkeklerde 117,75 cm?®, kadinlarda ise 111,83 cm?® olarak tespit etmislerdir ve



kadin erkeklerin cerebellum hacimleri arasinda istatistiki olarak anlamli fark
gbzlenmemistir. Nopoulos ve ark. (2000) yaptigr calismada erkeklerin cerebellum
hacmi ortalama 148,9 cm® ve kadinlarin cerebellum hacmi ise ortalama 139,3 cm?®
olarak hesaplanmis ve cinsiyetler arasinda anlamli fark gozlenmemistir. Acer ve ark.
(2008) 26 erkek ve 27 kadin bireyin MR goriintiileri {izerinden yaptigi ¢alismada,
cerebellum hacmini planimetri metodu ve nokta sayim yontemi kullanarak erkek ve
kadinlarda hesaplamistir. Yapilan bu ¢alismada planimetri yontemi kullanilarak

erkeklerde cerebellum hacmi 116,69 cm® ve kadinlarda 114,41 cm®

olarak hesap
edilmistir. Nokta sayim yontemi kullanilarak yapilan ¢alismada erkeklerde cerebellum
hacmi 116,34 cm®, kadinlarda ise 113,48 cm® olarak hesap edilmistir. Yapilan bu
calisma sonucunda erkeklerin ortalama cerebellum hacmi kadinlardan fazla bulunmus
olup, aralarinda istatistiki olarak anlamli bir fark bulunmamistir. Bu g¢alisma aymi
zamanda hacim c¢aligmalarinda kullanilan iki farkli yontemin degerlendirilmesi

acisindan onemlidir. Calismanin sonucuna gore nokta sayimi ve planimetri yontemleri

arasinda istatistiksel anlamda bir fark gériilmemistir.

Cerebellum kompleks bir yapt olup cerebrum’dan daha fazla noron
bulundurmaktadir. Cerebellumdaki néronlarin sayis1 fonksiyonel yapist itibariyle santral
sinir sistemindeki tiim ndronlarin yarisindan fazladir (Gokmen F, 2008; Taner D, 2010).
Cerebellum’un daha fazla noron bulundurmasi nedeniyle bilin¢li hareketlerin yapilmasi
ve motor hareketlerde etkili oldugu yapilan ¢alismalarda gosterilmistir (Raz ve ark.,
1998; Schmahmann ve ark., 2010). Pangelinan ve ark. (2011) yaptigi caligma
sonuglarina gore genel zeka katsayist (IQ) ve cerebellum hacmi arasinda g¢oguk ve
yetigkin bireylerde 6nemli iligski oldugu bulunmustur. Bu ¢alisma ayrica cerebellum’un
bilingli ve motor hareketlerde etkin rol aldigin1 géstermektedir. Paradiso ve ark. (1997)
yaptig1 calismada cerebellum hacmi ile genel IQ arasinda Snemli iliski olmadig:

bulunmustur.

Corteks cerebri’nin motor merkezleri elektrik akimi ile uyarildiginda, bu
merkezlerle ilgili kaslarda reaksiyon olmaktadir. Fakat cerebellum’un elektriksel
uyarilmasi ise herhangi bir kas hareketi veya duyu meydana getirmez. Cerebellum
cikarildiginda kas hareketlerinde ileri derecede bozukluklar goriiliir ve bu organin

sinyalleri cerebellum’un beyinin diger merkezlerinin kontrolii ve koordinatdrii oldugunu



ve beyin merkezleri ile viicut organlar1 arasinda diizenleyici olarak gorev aldiginm
gostermektedir (Noyan, 2000). Sunulan calismada cerebellum hacmi ve ak madde
hacminin erkek ve kadin bireylerdeki degerleri hesaplanmistir. Erkek ve kadin bireyler
arasindaki motor hareketlerdeki, kas koordinasyonundaki, spor aktivitelerindeki
farkliliklar cerebellum gri ve ak madde hacminin cinsiyetler arasindaki farkliligindan
kaynaklanabilir. Bu ¢alismamiz ileride bu konuda yapilacak calismalarda kullanilmak

tizere kaynak olusturabilir.

Calismamiz 20-40 yas arasi bireylerin cerebellum hacmi ve ak madde hacmini
erkek ve kadin bireylerde 6lgen bir arastirma olup, bu yas grubu erkeklerin cerebellum
hacminin kadinlarinkinden biiyiik oldugu belirlendi. Calismamiz neticesinde 20-40 yas
aras1 bireylerde cerebellum hacmi ile yas arasinda iliski goriilmemistir. Bu sonug bize
20-40 yas grubu bireylerin cerebellum hacminin stabil oldugunu gostermektedir. Ancak,
bu durum beyin dokusu i¢in farkli olup 20-40 yas arasi bireylerde beyin hacmi yasa
bagli azalma gostermektedir (Elfaki ve ark., 2013).

Literatiirde yas ile cerebellar hacim atropisi arasinda baglant1 oldugu ve artan
yas ile orantili olarak cerebellum hacminde azalma oldugu bulunmustur (Raz ve ark.,
1998; 2001; Jernigan ve ark., 2001; Walhovd ve ark., 2005; Pagani ve ark., 2008).
Pangelinan ve ark. (2011) yaptig1 ¢alisma sonuglarina goére 6-13 yas arasi ¢cocuklarda
artan yas ile cerebellum hacmi arasinda pozitif bir iliski oldugu goriilmiistiir ve
erkeklerin cerebellum hacminin kadinlardan fazla oldugu hesap edilmistir. Luft ve ark.
(1999) yaptig1 calismada cerebellum hacminde 20-30 yasina kadar artma oldugu, 50
yasina kadar bu degerin sabit kaldig1 ve 50 yasindan sonra ise cerebellum hacminde
azalmanin bagladig1 goriilmiistiir. Chung ve ark. (2005) Koreli bireyler lizerinde yaptigi
calismada 20’li ve 40’11 yaslardaki erkek ve kadinlarda cerebellum hacmini incelemistir.
Cerebellum hacmini 20’11 yaslardaki erkek bireylerde ortalama 141,85 cm® ve 40
yaslarindaki bireylerde ise ortalama 125,78 cm® olarak bulmustur. Cerebellum hacmini
20’li yaslardaki kadinlarda 126,96 cm® ve 40’li yaslardaki bireylerde ise 119,09 cm?
olarak bulmustur. Yaglanmayla birlikte cerebellum hacmindeki azalma erkeklerde
kadinlara gore daha fazla tespit edilmistir. Bu da yaslanmayla birlikte cerebellar
atrofinin gerceklestigini gostermektedir. Gocmen-Mas ve ark. (2009) yaptiklari

calismada yas ile cerebellar atrofi arasindaki iligskiyi incelemistir. Bu ¢alismada 27



kadin ve 27 erkekten olusan 18-34 yas aras1 geng grup, 35-60 yas arasi orta yas grup ve
60-84 yas arasi1 yasl grup erkek ve kadin bireylerin cerebellum hacimleri incelenmistir.
Calisma sonucunda geng, orta yash ve yasl bireylerden olusan gruplarin cerebellum
hacimleri arasinda istatistiki bir farklihik goriilmemistir. Ayrica yapilan analizler
sonucunda cinsiyetler arasinda da cerebellum hacim o6l¢iimlerinde istatistiki farklilik
gbzlenmemistir. Her bir grupta bulunan birey sayisinin az olmasi ve irksal farkliliklar ve
gruplardaki bireylerin viicut agirliklarinin esit olmamasi gibi nedenler farkli sonuglar

¢ikmasina neden olabilir.

Cerebral hacim ile agirlik ve boy arasindaki iliskiyi inceleyen ¢ok sayida
calisma bulunmaktadir (Peters ve ark., 1998; Nopoulos ve ark., 2000). Ancak cerebellar
hacim ile boy ve agirlik arasindaki iliskiyi inceleyen arastirmalar sinirlidir. Miller ve
Corsellis’in (1977) cerebrum flizerine yaptigi postmortem c¢alismada, 1860 dogumlu
erkeklerde beyin agirligit 1372 gr , 1940 dogumlu erkeklerde ise 1424 gr olarak
toplamda 52 gr fark ile hesaplanmistir. Yine ayni zaman dilimlerinde yapilan
Olgtimlerde kadinlarda 1242-1265 gr olarak totalde 23 gr farklilik hesaplanmistir. Bu
calisma bize nitelikli beslenme seviyesindeki artisin bireylerin uzunluk ve agirliklarina
ek olarak, cerebrum agirhiginda da yillik ortalama 1gr veya % 0,05 oraninda artis
oldugunu gostermistir. Chung ve ark. yaptigi ¢alismada (2005) cerebellar hacim ve
agirlik arasinda 20 yas grubundaki erkek bireyler arasinda pozitif bir iligki goriiliirken,
40 yas grubunda goriilmemistir. Cerebellar hacim ve agirlik arasinda 20 ve 40 yas
grubundaki kadinlar arasinda iligki gortilmemistir. Cerebellar hacim ve boy arasinda 20
ve 40 yas grubundaki erkek ve kadin bireyler arasinda bir iliski goriilmemistir.
Calismamiza 20-40 yas arasi bireyler dahil edilmis olup, bireylerin cerebellum hacmi ile
boy ve agirliklar1 arasinda pozitif yonde iligki goriildii. Boy ve agirhik wviicut
biiyiikliigiine bagl parametreler olup, cerebellum hacmi ile iligkili olmasi1 biyolojik bir

gercektir.

Calismada cerebellum hacmi ile VKI arasinda bir iliski goriilmemistir.
Literatiirde bu konuda yapilan ¢aligmalar smirhidir. Taki ve ark. (2008) MR
gorlntiilerini kullanarak 690 erkek ve 738 kadin olmak iizere toplam 1428 kisi ile
voksel-tabanli dlgiimler kullanarak yapti§1 hacim 6lgiimlerinde, bireylerin VKI ile gri

madde hacmi arasindaki iliskiyi arastirmistir. Yapilan hacim dl¢iimleri sonucunda VKI



ve gri madde hacim orani arasinda erkeklerde negatif bir korelasyon goriiliirken,
kadimlarda goriilmemistir. Olgiimler neticesinde erkeklerde cerebellum’un anterior
lobunda ve cerebrum’un gesitli bolgelerindeki gri madde hacmi ile VKI arasinda negatif
korelasyon goriilmiisken, cerebellum’un posterior lobu ve cerebrum’un farkli ¢esitli
bolgelerindeki gri madde hacmi ile VKI arasinda pozitif korelasyon goriilmiistiir.
Bolgesel gri madde konsantrasyonunda yiikselme oldugu kadar azalmalarda
goriilmesine ragmen artan VKI degeri ile erkelerde gri madde hacminde azalma
gorilmektedir. Erkeklerde bolgesel gri madde konstantrasyonu; yasa, alkol alimina,
hipertansiyon gecmisine gére diizenlendiginde VKI ile aralarinda negatif korelasyon

gorilmiistiir.

Erkeklerde ve kadinlarda ak madde hacmi ortalama 40,48 ve 50,41 cm® olarak
tespit edildi. Kadinlarda ak madde hacmi erkeklerden % 19,70 daha fazla bulundu. Ak
madde hacim oranlarina baktigimizda; tiim bireylerin ortalama ak madde hacim orani %
30,90 olarak hesaplandi. Erkeklerde ortalama ak madde hacim orant % 27,06 ve
kadinlarda ortalama ak madde hacim oram1 % 36,63 olarak hesaplandi. Dolayisiyla
kadinlarin ak madde hacim oraninin erkeklerden daha fazla oldugu gozlendi. Cerebellar
ak madde bilindigi gibi beyincigin yakin ya da uzak boliimlerini birbirine baglayan
intrinsik, afferent ve efferent liflerden olusmaktadir. Insanda ak madde hacmine baglh
olarak erkek ve kadinlarda fonksiyonel farkliliklar gortilebilir. Bu farkliliklar kadinlarda
ak madde miktarinin fazla olmasma baglh olarak, cerebellar liflerin tasidig: iletilerin
daha hizli cevaplandirilmas: ve kadinlarin hareket modellerinin erkeklerden daha hizli
planlanmasi seklinde sonuglanabilir. Insanda cerebellar hemisferlerin lateral bolgeleri
ozellikle el ve parmak ile ince ardisik hareketler yapmalarina ve konusma yeteneklerine
paralel olarak ¢ok gelismis ve oldukca biiylimiistiir. Lateral cerebellar alanlar ile korteks
arasindaki biitlin haberlesme sadece primer motor korteks ile degil, premotor alan,
primer ve duysal assosiyasyon alanlari sayesinde olmaktadir (Guyton ve Hall, 2001).
Lateral cerebellar alanlar ile korteks arasindaki haberlesmenin bir kismi assosiyasyon
alanlar1 ile saglanmaktadir ve kadinlarda bu alanlarin daha biiyiik olmasi1 bu alanlar
daha fonksiyonel kullanmalarini saglamaktadir. Kadinlarin ellerini ve parmaklarini
erkeklere gore daha ardisik ve seri kullanmalar1 ve kadinlarin konugma konusundaki
iistiinliikleri bize bu fonksiyonlarin cerebellum ak madde hacminin kadinlarda fazla

olmasindan kaynaklandigini diisiindiirmektedir.



Hoogendam ve ark. (2012) yaptig1 calisma sonuglarina gére ak madde hacmi
erkeklerde ortalama 24,9 cm?® ve kadinlarda ortalama 25,15 cm?® olarak tespit edilmistir.
Artan yas ile orantili olarak cerebellar ve cerebral hacmin azaldigi bulunmustur. Artan
yas ile cerebellar hacimdeki azalma her yil ortalama 0,35 ml olarak bulunmustur.
Cerebellar ak madde hacminde erkeklerde her yil 0,13 ml azalma goriliirken,
kadinlarda her yil 0,09 ml azalma oldugu goriilmiistir. Liu ve ark. (2003) fractal
dimention (FD) yontemi kullanarak yaptig1 calismada, cerebellar ak madde hacim
Olctimlerinde, cerebellum’un oldukga yiiksek fraksiyonel bir yap1 oldugunu ve erkek ve
kadin bireylerin cerebellar ak madde hacim degerlerinde 6nemli bir farklilik olmadigini
tespit etmistir. Calismamiz sonucunda erkeklerin cerebellum hacmi ortalama 149,75
cm®, kadinlarda ise ortalama 137,30 cm® olarak hesaplandi. Yapilan arastirmalardaki
birey sayisinin azhig1 veya yontem farkliliklar1 sonuglarin birbirleri ile drtlismemesine

sebep olabilmektedir.

Calismamiz 20-40 yas arasi1 bireylerin cerebellum hacmi ve ak madde hacmini
erkek ve kadin bireylerde Olgen bir arastirma olup bu yas grubundaki kadinlarin ak
madde hacminin erkeklerden biiyiikk oldugu belirlendi. Yapilan 6l¢iim ve analizler
sonucunda cerebellar ak madde hacmi ve hacim orami ile yas, boy, agirhik ve VKI
arasinda anlamli bir iliski goriilmedi. Literatiirde bu konuda yapilan ¢aligmalar oldukca
stnirhdir.  Jernigan ve ark. (2001) yaptigi calismada artan yas ile beraber
cerebellum’daki beyaz madde miktarinin gri maddeye gore daha hizli azaldigim

gostermistir.

Biyolojik yapilara iliskin sayisal verilerin elde edilmesinde kullanilabilecek
birgok yontemin var olmasi, bu yontemler arasindan en giivenilir ve en uygun olaninin
secilmesi sorununu da beraberinde getirmektedir. Literatiir ¢alismalarina bakildiginda
cok farkli metotlar kullanilarak hacim hesaplamalar1 yapildigi goriilmekte olup, bu
metotlar icerisinde stereolojik Ol¢limler, segmentasyon teknigi ve gorlintii analiz
programlari, diflizyon tensor goriintiileme ve voksel tabanli dlglimler olmak iizere bir
cok farkl yontem kullanilmistir (Nopoulos ve ark., 2000; Liu ve ark., 2003; Walhovd
ve ark., 2005; Pagani ve ark., 2008). Insanlarda cinsiyetler arasindaki biyolojik ve
davranigsal farkliliklar birgok arastirmaci tarafindan histolojik ve in-vivo goriintiilleme

yontemleri kullanilarak incelenmistir (Cosgrove ve ark., 2007; Good ve ark., 2007).



Hacim hesaplamalarinda farkli goriintii analiz programlart kullanilmaktadir. Bu
programlar icerisinde en sik kullanilanlari, DicomWorks ve ImageJ gibi programlardir.
Belirttigimiz programlarin kullanimi ile dogru bir sekilde hacim hesabi yapilabilecegi
literatiirde belirtilmektedir (Acer ve ark., 2007). Bilgisayar destekli sistemler
kullanilarak yapilan c¢aligmalarda, kullanici hatasina 6nemli derecede sinirlama
getirilmekte olup yapilan calismanin giivenilirligi ve tekrarlanabilirligi de artmaktadir

(Howard ve Reed, 1998).

Stereoloji iki boyutlu kesitlerden elde edilen verilere dayanarak, onlarin
gercekteki tic boyutlu Ozellikleri ile ilgili yorumlar yapilmasini saglar. Stereolojik
yontemlerden Cavalieri yontemi kullanilarak goriintii analiz sistemleriyle yapilan
Olgiimler ile BT ve MR goriintiileri iizerinden sinirlar1 birbirinden ayirt edilebilen
normal ya da patolojik olan her organ ya da yapinin hacmi tarafsiz ve etkin bir sekilde
hesaplanabilir (Canan ve ark., 2004). Cavalieri prensibi kullanilarak organlarin hacim
hesabinin yapildig1 ¢cok sayida ¢alisma mevcuttur (Roberts ve ark., 2000; Sahin ve ark.,
2003a; 2003b). Planimetrik teknikler ise bilgisayar destekli programlar kullanilarak 3
boyutlu yeniden yapilandirma ¢alismalarini igermektedir (Odaci ve ark., 2005). Sahin
ve Elfaki (2012) hacmi hesaplanacak yapinin bilgisayar ekrani iizerinde goriintli sinir
hattinin karmasik olmadigi durumlarda, yari otomatik planimetre yonteminin nokta
sayim yonteminden daha etkin oldugunu bildirmistir. Calismada, sagittal yonelimli MR
goriintli serilerinin sinir hatlarimin diizgiin olmas1 sebebi ile yari otomatik planimetri
yontemi se¢ilmistir.

Organ ve yapilarin hacminin stereolojik uygulamalardan Cavalieri prensibi
kullanilarak tarafsiz ve etkili bir sekilde hesaplandigi bilinmektedir (Robert ve ark.,
1993). Ancak, orneklemede tarafliligi ortadan kaldirmak igin ilk kesit, kesit kalinlig
mesafesindeki herhangi bir noktadan rastgele olarak alinmaya baslanmali ve esit aralikli
kesitler alinacak sekilde kesme islemine devam edilmelidir (Sahin ve Elfaki, 2012). Bu
uygulamada dikkat edilmesi gereken en Onemli nokta ilgilenilen yapidan yeterli
miktarda goriintii elde edilmesi i¢in goriintiilerin ne kadar aralikla alinacaginin tespiti,
goriintiilerin birbirine paralel olmasi ve ilgilenilen yapmin hepsinin 6rneklenmesidir
(Sahin ve ark., 2003). Bizim sonuglarimiz Cavalieri metodunun cerebellum hacmi ve
hacim oranmin hesaplanmasinda dogru bir yontem olarak kullanilabildigini

gostermektedir.



Odact ve ark. (2003) yaptiklari ¢alisgmada hacim Olglimiinde kullanilan BT
goriintli diizlemlerinin farkli olmasinin yapilan hacim 6l¢limii sonuglarinda istatistiksel
olarak fark olusturmadig: bildirilmistir. Kesitlerin yonii tarafsizligi etkilememekte olup,
elde edilen kesit sayisinin degismesi hacmin oldugundan fazla ya da az hesaplanmasina
neden olmaktadir. Sahin ve Ergiir (2006) tarafindan yapilan ve MR goriintiileri
tizerinden kesit kalinliginin karaciger hacmine olan etkisinin arastirildigi ¢alismada,
dogru hacim hesabi1 i¢in en uygun kesit kalinliginin 4-5 mm oldugu tespit edilmis olup,
bu kalinlikta kalibrasyona gereklilik duyulmadan hacim hesab1 yapilabilecegi
bildirilmistir. Diger kesit kalinliklar1 i¢in hacim degerinin bir diizeltme formiilii
vasitastyla her bir kesit kalinligina gore farkl diizeltme faktorleri kullanilarak gergek
degere yaklastirilmasi gerektigi bildirilmistir. Bu da yapilamiyorsa tiim ¢aligmada ayni1
kalinlikta kesitler alinmalidir. (Sahin ve Ergiir, 2006). Sunulan ¢aligmada MR goriintii
serilerinin kesit kalinligi 1 mm olup tim deneklerde ayni kalinlikta kesitler alindu.
Boylece, gergek degerden sapma orani sabitlenerek dogru hesaplama yapilmasi

saglandi.

Cavalieri metodunun dogrulugunun degerlendirilmesinde ve elde edilen kesit
sayisinin yeterli olup olmadigini sorgulamak amaciyla hata katsayis1 kullanilir.
Planimetri yontemi ile hata katsayisini hesaplamak amaciyla Mazonakis ve ark. (2002)
tarafindan aktarilan formiil kullanilabilir. Calismada her bir denek i¢in kesit sayisinin
yeterliligi bahsedilen formiil yardimi ile hesaplanmistir. Hata katsayisi %5 ve daha
altinda ise kesit orneklemesinin yeterli olduguna karar verilir, aksi durumda kesit say1si
artirtlmalidir. Ayrica, Cyteval ve ark. (2002) MRI goriintiileri kullanilarak yapilarin
hacim hesabinin %95 dogrulukla hesaplanabildigini gostermistir.

Cerebellum ve ak madde hacmi ile hacim oranlarimin erkek ve kadinlardaki
Ol¢timii sonucunda hata katsayr degerleri % 0,78 ila 2,46 arasinda degismektedir.
Cerebellum ve ak madde hacmi ile hacim oranlarinin hata katsay1 degerlerinin %5’den
diisiik oldugu ve 1/5 oraninda kesit 0rneklemesi ile elde edilen MR goriintiilerinin

yeterli oldugu goriilmistiir.

Yapilan literatiir incelemesinde, etkinligi arastirmak amaciyla zaman faktoriinii
kullanan sinirli sayida ¢alisma bulunmaktadir (Odaci ve ark., 2003; Sahin ve ark., 2003;
Akbas ve ark., 2004; Bilgi¢ ve ark., 2005; Emirzeoglu ve ark., 2005; Sahin ve Ergiir,



20006). Literatiirde diger ¢alismalarda zaman kavrami dikkate alinarak bir degerlendirme
yapilmamistir. Bermel ve ark. (2003) beyin atrofisini MR goriintiileri iizerinden yar1
otomatik planimetri yontemi kullanarak inceledikleri ¢alismada, her hastanin 6l¢iimii 30
dakikada hesaplanmistir. Calismada 1 mm kalinligindaki kesit goriintiileri, yari
otomatik planimetri yOntemi kullanilarak her bir bireyde ortalama 23 dakikada

hesaplanmustir.

Cavalieri yontemi kullanilarak goriintli analiz sistemleriyle yapilan dl¢timlerin
fazla zaman almamasi, egitimli personel gerektirmemesi, ilave bir masrafa yol
agmamasi gibi nedenlerden dolayr rahatlikla kullanilabilir bir yontemdir (Sahin ve ark.,
2003). Cavalieri prensibi ayrica rutinde kullanilan MR goriintiileri iizerinde
uygulanabildiginden geriye doniik ve ileriye doniik incelemeler yapilmak istendiginde

kullanilabilmektedir.

Sonug¢ olarak, calismamizin 20-40 yas grubu bayan ve erkek bireylerde
cerebellum ve ak madde hacim verilerinin olusturulmasi ve bundan sonra yapilacak
caligmalara rehber olmasi agisindan ©nemli olabilecegi kanaatindeyiz. Sunulan
calismada oOnerilen yaklasimin kullanilmasi ile cerebellum ve ak madde hacimleri MR
goriintiileri lizerinden tarafsiz ve etkin bir sekilde hesaplanabilir. Cerebellum’daki gri ve
beyaz cevher hacmine ait degisikliklerin cerebellum’daki atrofiyi anlamada ve

norodejeneratif hastaliklar: teshis etmede faydali olabilecegi diisiincesindeyiz.



6. SONUC VE ONERILER

Sunulan ¢aligmada erkek ve kadin bireylerde cerebellum hacim Ol¢limleri
stereolojik yontemlerden Cavalieri yontemi kullanilarak hesaplandi. Elde ettigimiz
veriler erkek ve kadin bireylerin cerebellum hacimleri arasinda karsilastirma

yapmamiza imkan sagladi.

Bireylerin tanimlayici 6zelliklerine baktigimizda kadin ve erkek bireylerin yas
ortalamasinin benzer oldugu bulundu. Erkeklerin kadinlara gére daha uzun ve daha agir
oldugu gozlendi. Erkeklerin viicut kitle indeksi degerleri ile kadmlarin VKI degerlerinin

benzer oldugu bulundu.

Calismamiz sonucunda cerebellar ak maddenin bayanlarda daha fazla oldugu

ve cerebellum hacmi ile gri madde hacminin erkeklerde fazla oldugu tespit edildi.

Hacim oranlarin1 karsilastirdigimizda, erkeklerin gri madde hacim oraninin
kadinlarin gri madde hacim oranindan yiiksek oldugu, ak madde hacim oranini kadin ve
erkek bireylerde karsilastirdigimizda ise kadinlarin ak madde hacim oraninin

erkeklerden yiiksek oldugu tespit edildi.

Konu ile ilgili yapilan diger calismalar incelendiginde elde edilen hacim
degerleri arasinda farkliliklarin bulundugu goriilmektedir. Bu farkliliklarin sebebi
arastirildiginda, incelenen bireylerin yas araligi, irksal farkliliklar, denek sayisinin
miktari, hacim hesaplamalarinda kullanilan farkli yontem ve teknikler sonucun farkl
cikmasma sebep olabilmektedir. Calismalar sirasinda denek sayisinin miimkiin
oldugunca fazla olmasina dikkat edilmeli ve miimkiinse ayni yas gurubunda farkh

cinsiyette guruplar olusturularak ¢aligsma yiiriitiilmelidir.

Sonug olarak, ¢alismamiz Cavalieri prensibi kullanilarak MR goriintiileri
tizerinden cerebellum hacim hesabinin ¢ok giivenilir bir sekilde hesap edilebileceginin
gostermektedir. Yapmis oldugumuz ¢alisma agikca gdstermistir ki cerebellum hacmi ve

ak madde hacmi erkek ve kadin bireylerde degiskenlik gostermektedir.

Saglikli insanlarda cerebellar hacim datalarin1 bilmek hastaliklarin teshisinde
ve cerrahi miidahalelerde 6nemli olup, cerrahi yaklasimlarda potansiyel riskleri

minimalize etmek agisindan Onem tasimaktadir. Buna ragmen insanlarda cerebellar



hacim aragtirmalarinda, yeterli dataya ulasilamadigindan aragtirmacilar arasinda genel
hacim degerleri hakkinda fikir birligine varilamamistir. Bilim insanlarina daha faydali

olunabilmesi i¢in bu ve benzeri ¢alismalarin artmasi gerekmektedir.
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